THE EDUCATIONAL POTENTIAL OF A COMPUTERIZED BIOLOGY DATABASE
CREATING AND EXPLORING THE EDUCATIONAL POTENTIAL OF A
COMPUTERIZED PICTORIAL BIOLOGY DATABASE

by

GRAHAM J. PASSMORE, B.Sc.

A Project
Submitted to the School of Graduate Studies
in Partial Fulfillment of the Requirements
for the Degree
Master of Science in Teaching

McMaster University

(C) Copyright by Graham Passmore, August, 1995
MASTER OF SCIENCE IN TEACHING (1995) McMASTER UNIVERSITY
(Biology) Hamilton, Ontario

TITLE: Creating and Exploring the Educational Potential
of a Computerized Pictorial Biology Database

AUTHOR Graham J. Passmore, B.Sc. (Guelph University)

SUPERVISORS: Dr. C. Beattie
Dr. D. G. McDonald

NUMBER OF PAGES: v, 121
ABSTRACT

The Biology Department at McMaster University is interested in courses for which students can generate computerized text presentations around a computerized data base of biological images. The student texts are to be added to the pre-existing data base at the end of the semester. This project describes the problems encountered when developing a CD-ROM to contain the images. The images were initially incorporated onto Kodak photo CDs. To place all the images on a single CD-ROM they were compressed into a JPEG file format. The suitability of Asymetrix Multimedia ToolBook 3.0 and Microsoft PowerPoint 4.0 for use by students preparing accompanying text is then assessed.

A development strategy for the data base is then explored. Hypertext is judged to be the environment of choice. Research into the structuring of hypertext to enhance student learning reveals that the development of tutorials to accompany the students' texts and the computerized data base will be a crucial step. Behaviourist and cognitive psychology strategies for learning are used as a platform to suggest a structure for the data base. Finally, interface design research is used to outline the format of the student presentations.
ACKNOWLEDGEMENTS

I would like to express my thanks to all of those who assisted me in any way during the work on this project. Special thanks to: Dr. Catherine Beattie for her example of dedication and hard work; Dr. Gordon McDonald for his enthusiasm for education and his vision; and the staff of the Education department at McMaster University and the Audio-Visual department of McMaster University Medical Centre for the use of their equipment, their technical guidance and for helping me put this work in perspective.
# TABLE OF CONTENTS

## CHAPTER ONE

Introduction .................................................. 1

## CHAPTER TWO

The Bicednet Project ........................................... 5

## CHAPTER THREE

Toolbook 3.0 .................................................. 14

## CHAPTER FOUR

Microsoft PowerPoint 4.0 .................................... 34

## CHAPTER FIVE

The Effectiveness of Multimedia ............................. 51

## CHAPTER SIX

A Proposed Development Strategy for the Biology Department’s 
Self-Education System ......................................... 76

## CHAPTER SEVEN

The Design of Student Created Presentations ............... 89

## CHAPTER EIGHT

Matching the Proposed System to Behaviourist and Cognitive 
Psychology Theories of Learning ............................ 97

## CHAPTER NINE

Summary and Future Steps .................................... 107

## BIBLIOGRAPHY .................................................. 118
Chapter one

Introduction

The objective of this introduction is to splice the project chapters together. In this project the creation of a computerized data base of biological images for McMaster University's Biology Department is described. Before the work began, Professor D. G. McDonald had conceptualized an electronic data base of biological images that could be used as the core part of a computerized self-education system. A body of work called the Bioednet project was seen as a potential starting point for the data base as it required the generation of five thousand computerized biological images. McMaster University's two and a half thousand image contribution to the Bioednet project constituted the first part of this project.

It was thought that the move toward computerized self-education would begin with one or two senior biology courses that use the twenty-five hundred images as resource material. In these initial efforts, it was envisioned that students would be assigned several images on a CD-ROM at the start of the semester. The students' role would be to provide background information about the organisms represented in the images which they were assigned, and then to introduce the
material to their peers in class as a computerized presentation. Students learn whatever they think appropriate to complete the assignment. They have to review the material twice on this type of course; firstly to create the presentations and secondly to show the presentation and be prepared to answer questions. By learning the material themselves, students become responsible for their own educations. High quality, in-depth presentations reflect high quality learning experiences.

After the presentations, the professors would be available to answer questions and expand upon difficult concepts or salient matters as they saw fit. At the end of the semester the presentations would be incorporated onto CD-ROM and made available to the next semester's class. Over time it was thought that the CD-ROMs would become a rich source of information.

Aside from creating the data base, the objectives of this project included investigating a suitable format for the student presentations and the structure of data on the CD-ROMs. The ideal presentation format and data structure were considered to be those that would optimize student learning times and comprehension.

The first chapter describes the background steps that provided impetus for the project, and the route taken to create the data base. The aims of the project are listed and explained fully at the end of chapter two. Chapters three and four concern
the software packages, Asymetrix Multimedia ToolBook 3.0 and Microsoft PowerPoint 4.0 respectively. In both chapters a strategy for incorporating computerized images into the software is provided in detail.

In chapter five, a literature review of computerized versus conventional education studies is used to help justify setting up a self-education system. Chapter six begins with a description of hypertext and then goes on to propose a structure for information on the database that is based on hypertext. The combination of an hypertext environment with CD-ROM optical storage is defended as an ideal medium for individualized or self-education. Chapter six also discusses the importance of computerized tutorials to a computerized self-education system. It is proposed that developing the capacity for students to create their own tutorials is critical to the growth of a computerized education system where students learn by discovery. Student generated tutorials are needed to increase the range of courses offered on the system and to alleviate faculty from this responsibility. Faculty do not have the time to create computerized tutorials. By introducing topics and providing problem solving exercises, tutorials also fulfill the feedback and remediation requirements that research indicates are necessary for successful discovery learning. The importance of chapters two and three becomes apparent in chapter six where the suitability
of both software packages for the proposed computerized self-education system is assessed.

Design suggestions for the students' presentations and navigation aids on the CD-ROMs are provided in chapter seven. The final chapter critically assesses the usefulness of the proposed ideal self-education system, by comparing how the proposed structure of data on the CD-ROMs conforms to behaviourist and cognitive science theories of learning.

During the investigation of a structure for the student created presentations and the data base it became apparent that as the number of student generated presentations increased, storing them would require many CD-ROMs. If many courses were eventually offered using the data base a server would be a more suitable storage method. CD-ROMs for individual courses could be taken from the server as required. Therefore the data base structure described in this project applies to the linking of student created presentations on CD-ROMs and a server, as the former would be extracted from the latter.
Chapter two

The Bioednet Project

Project Background

There is an interest among some faculty of McMaster University's Biology Department in developing a component for a computer based, student self-education system. This work is a starting point for the envisioned education system. The goal is to create a multimedia data base for which senior undergraduate students create accompanying computerized text. The text and images would be demonstrated to peers in class by the student creator and then incorporated into the data base so that it becomes larger and more comprehensive over time. At the start of each semester portions of the data base that relate to various courses would be made available to new students on CD-ROM.

The hypothesis of the interested parties is that exploration of the CD-ROMs and other resources, such as the Internet, will allow students to learn in a more "natural" way than conventional education i.e., according to their interests. It is hoped that this "natural" system will be more productive than the conventional system. Furthermore, it is hoped that the proposed system will prove to be, or will point the way towards a more cost effective means of education.
The students will be assigned images from the data base to research. Their findings will be presented by them in class. After the presentations the lecturer will be available to handle questions and explain difficult concepts.

In the Bioednet project, a consortium of five universities was commissioned by the Ontario Provincial Ministry of Education and Training to collate and digitize images of biological specimens. The work began in the spring of 1994, and by September 1994 each university had access to over 5000 images through an anonymous file transfer protocol (FTP) site located at Guelph university. The images have high resolution file formats such as Joint Photographic Experts Group (JPEG) and Photo Compact Disc (PCD). The Bioednet project was seen as a potential starting point for developing the "electronic book", course material.

For its part in the Bioednet project, McMaster University's biology department arranged for access to the slide collections of several McMaster professors, as well as the prestigious Gunn, Gilmour and fungi slide collections housed at the Royal Botanical Gardens. North American birds and trees are the subjects of the Gunn and Gilmour collections. Approximately twenty five hundred slides were chosen for the project. High quality images of as many species as possible were chosen from the Gunn and fungi collections. In addition to these selection criteria, several images of the same species were chosen from the Gilmour
collection so that a range of detail from the whole plant to the leaves was included.

Preparation of Images for the CD-ROM

Copyright Issues

Initially the RBG was concerned about losing control of the slide material. However an agreement was eventually reached whereby McMaster University gained access to the slides. In this agreement, the RBG will be given a CD-ROM of the slides and McMaster University will restrict its use of the images to non-commercial activities. Fortunately this meets the goals of both parties; the RBG hopes to market the CD-ROM and McMaster University can use the images to build an electronic data base.

Digitizing the Images

It was decided that the most cost effective and efficient means of digitizing the slide images would be to put them onto Kodak Photo CDs. Arrangements were made for myself and McMaster University staff to view the RBG's slides and become familiar with their filing system so that the lengthy process of sorting and cataloging could begin. Once selected and sorted, the slides were digitized onto twenty Kodak Photo CDs through Duncan and Wright Cameras 4. The turn-around time for digitization was

---

1 Duncan and Wright Camera 4, 3350 Fairview St, Burlington ON.
approximately five working days. Digitized images on Kodak Photo CDs are in the PCD file format.

The Data Base

During the original mounting process the RBG slides had been identified and described on their outer protective covers. This information was recorded as the slides were sorted. In some cases the information provided on the slides was incomplete. Adding to the problem of incomplete information was the fact that the Linnaeic classification used by the RBG was dated in comparison to modern field guides. Complete identification of images was sometimes impossible without expert assistance. Some of the fungi remain unidentified. Gathering information about the slides provided by McMaster University professors was easier as the photographers were close to hand. The information on each slide was entered into an I.B.M. compatible Fox Pro data base. Like sorting through the slides, entering data into the data base was a time consuming process.

JPEGging and Rotating the Digitized Images

Kodak Photo CDs contain five resolutions of each image. Unfortunately the mechanized sorting system used by Kodak leaves many of the Photo CD images either inverted or at 90 degrees to

---

2 Microsoft Corporation, 6300, NW Drive Mississauga, Ontario
upright. It was hoped that an upright copy of all the images could be placed on a single CD-ROM. This CD-ROM would serve as a start for the data base and as McMaster's contribution to the Bioednet project. To meet the objective of a single CD-ROM, the middle resolution of each image was rotated and JPEGed. JPEG was the Bioednet consortium's preferred file format.

JPEG is a compression / decompression algorithm that reduces the size of digitized files by saving only enough information for restoration of the image. During compression of a JPEG file the image is broken down into blocks of common colour. Only the colour and position of the coloured blocks that make up the JPEG file are retained in the computer's memory. When the image is restored, all the pixels in a block are given the same colour. Bitmap files require more memory storage space as the colour and position of every pixel is computed.

JPEG compression ratios refer to the number of pixels in a common colour block. The greater the compression ratio used the larger the blocks of common colour and the lower the quality of restored images. Little change in image quality is noticeable at a compression ratio of 20:1 but at larger compression ratios the image starts to degrade. Using a compression ratio of 20:1, the Photo CDs middle resolution compresses to about 200 kilobytes. A Compact Disc Recordable (CD-R) can hold 640 megabytes of data. All
two and a half thousand images should fit on a single CD-R using a 20:1 compression ratio.

Hijaak PRO 2.0 is a commercial software package available from Inset Systems\textsuperscript{3}. It is capable of rotating the images and converting the PCD files to the JPEG file format. Using Hijaak PRO 2.0 on a Dell Dimension, XPS, 486-66, midsize, personal computer with 16 megabytes of RAM, the conversion of individual PCD files took about 15 seconds. The average number of images on the Photo CDs was 126, so a little over 30 minutes was needed to convert all the files on a disc. The converted images were saved onto the hard drive.

When the images were on the hard drive they were opened up to determine if they required rotation. The status of images does not always correspond to the thumbnail sketches provided in the Photo CD cover sleeve, so all the images had to be checked. On this Dell Dimension XPS computer, Hijaak PRO 2.0 performed 180 degree rotations in about ten seconds; 90 degree rotations took approximately three minutes. Many of the images had to be rotated 90 degrees. The software cannot be programmed to perform multiple conversions and the conversion process was also time consuming and required constant operator attention.

Initially the JPEG files were rotated and re-saved onto the hard drive using the same file name. Though this seemed like a

\textsuperscript{3} Inset systems, 71, Commerce Drive, Brookfield CT.
logical procedure, it always created a JPEG error. During conversations with Inset Systems' technical support the problem was identified as a bug in the JPEGging facility of the software. Rotating and re-saving JPEGged files corrupts the software's JPEGging file, the leadtech.dll file. To avoid the JPEGging bug, the PCD images were opened from the Photo CD and rotated before conversion to JPEG. Files rotated and converted in this way could be saved to the hard drive over the original JPEG files.

An early version of the NEC 3X Multispin CD-ROM drive was used to open up the digitized images. Five of the Photo CDs could not be opened, but they could be read on a Macintosh CD-ROM drive. It was assumed that the Photo CDs were corrupt and they were returned to Kodak Canada. Kodak pointed out that there is a compatibility problem between this early NEC 3X Multispin and the Kodak PCD file format. NEC agreed to replace the CD-ROM drive. It would have been better to have a CD ROM drive that is compatible with Kodak Photo CD files, one with the KODAK logo on it.

Making the CD-ROM

By September 8, 1994, 1200 images had been cataloged on the data base, JPEGged and rotated. These images were copied onto

NEC Technologies Inc., 159 Swanson Rd, Boxborough, MA. 01719
computer tape using a backup tape drive (model # 141080 QIC80(80-240 MB) and software from MicroSolutions ⁵. After the images had been down-loaded onto the computer tape the same technology was used to restore them onto the hard drive of a computer associated with a CD-R ⁶. Back up involves the transfer of chunks of bytes from computer to computer tape. The opposite occurs in restoration; information is transferred from computer tape to computer. Backup chunks differ in size from restoration chunks, but it is not known by how much as the software's files are proprietary.

When the Photo CD images were converted to JPEG files the numbering system of the Kodak Photo CDs was used as the Bioednet consortium did not have a system at the time. When the files were backed up, the Bioednet consortium's numbering system was available and a batch file was created to change the numbering system of the JPEGged files. From the hard drive of this computer, the JPEG files were read onto a blank CD-R disc.

In the next two chapters, instructions for accessing the CD-ROM images and incorporating them into Toolbook 3.0 and PowerPoint 4.0 are provided. These chapters are used as a basis on which to determine the suitability of the software for the proposed CD-ROM based, self-education system. Suitable software

⁵ Quest Development Corporation, 708, Fiero Commerce Park, #10, San Louis, Obispo.CA93401
⁶ Philips Compact Disc recorder (CD521)
should be able to import JPEG files in a reasonable amount of
time and work on I.B.M. and Mackintosh platforms; it should also
be inexpensive and workable with a minimum of computer skills.
During the initial implementation trials the chapters can also be
used as guidebooks to help students create presentations.
Chapter three

Toolbook 3.0

Toolbook 3.0 and the Book Metaphor

Toolbook 3.0 is a software authoring package. Figure one illustrates the hierarchical arrangement of Toolbook 3.0's

Figure 1 The Toolbook 3.0 Hierarchy
components. Presentations are created by incorporating computer scripts (programs) into specific components of the hierarchy.

The Toolbook 3.0 System book can contain any number of Toolbook 3.0 books. Each Toolbook 3.0 book can hold many backgrounds, and many pages may be placed within each background. In turn, pages may contain many graphical objects and text characters. For the proposed student, self-education system we are only concerned with the book level and its components. For most of the presentations, only one background will be needed.

To create a Toolbook 3.0 book the most difficult and important concept students would have to grasp is the relationship between a page and its background. Objects in a background are visible on every page associated with that background. For example, a Record Field will be placed in the background of most presentations. A Record Field is a rectangular, graphic object capable of holding text. When new pages are created the Record Field automatically appears, it is refreshed, ready to accept text and in the same position as on previous pages. Text can be entered into a Record Field on any page of a book, but that text will only be visible when the page it is entered on is active. The active page is the page on the screen. Different text on every page duplicates the effect of a book. Most of the images will be placed in pages; like the text
they will only be visible when the page they are associated with is active.

Every Toolbook 3.0 object may have a script (computer program) that responds to user actions. Usually objects are programmed to respond to a mouse, button click message. When the mouse cursor is on top of a graphic object and the button is clicked, the object responds according to the dictates of its button click handler (script). If the mouse is clicked over a part of the screen that does not contain a button click handler, the button click message passes up the Toolbook 3.0 hierarchy until a handler script is reached. If no handler script has been located by the time the message reaches the System Book, Toolbook 3.0 ignores the message. The scripts associated with Toolbook 3.0 objects and multimedia resources control the speed at which a presentation will play. Some thought should be given to this aspect of a presentation as having information appear too slowly or quickly could annoy the user and reduce a presentation's usefulness. The task is not easy as presentations that show smoothly on a powerful computer may run very slowly on a less powerful machine. Fortunately the machines that presentations will be shown on are known in this instance. Students can adapt their presentations to the computing power of the machines that will be used for display.
Importing Images into Toolbook 3.0

Two methods of importing digitized images into Toolbook 3.0 are described here. The first method imports JPEG files using Hijaak Pro 2.0 as an intermediary. The second method imports PCD files from Photo CDs.

Method 1. Importing JPEG Files into Toolbook 3.0.

Toolbook 3.0 does not have a filter for handling JPEG files. In this method, Hijaak PRO 2.0 is used as an intermediary software package to convert JPEG files to a bitmap format. The conversion process could be used to convert the images to other file formats compatible with Toolbook 3.0. Italics are used in the following descriptions to denote Toolbook 3.0 functions that have to be clicked by the user.

1. Insert the CD-ROM into the hard drive and choose or create a directory on the hard drive to accept the bitmap image(s).
2. Open Hijaak PRO 2.0.
3. Click on File in the command menu.
4. Click on Open in the File menu to access the Open viewer.
5. Click on the Drive combo box.
7. Double click relevant options until the desired JPEG files are visible.
8. Select the required files in the *File* Box.

9. When a file is selected the *Options* button becomes highlighted. Open the Options viewer and make sure that scaling is set to Off and the 512x768 image resolution is selected.

10. Click on *OK* to select the image options and close the Options viewer. Close Open viewer by clicking on *OK*.

When the selected files are open a file format conversion has to be specified so that Hijaak PRO 2.0 can convert the JPEG files.

11. Open the *File* menu.

12. Click on *Convert*.

13. In the viewer that appears select *Convert Current Image to File* (*save as*...) and then click on *OK*.

14. A *Save As* box appears, click on the *Files of Type* box.

15. Select *bitmap* (*bmp*).

16. With the *bmp* extension selected the Options button becomes highlighted.

17. Click on *Options* to open the Options viewer and select: *Scaling* = *Fit in Frame*, *Flavor* = *Windows 3*, and *Distort Aspect*=1.

The above options are the default bitmap settings. It is only necessary to check the JPEG-Bitmap conversion options at the beginning of a session. Be sure to check the conversion options...
at the start of future sessions in case they have been altered.

18. Click on OK to close the Options viewer.

Hijaak Pro 2.0 now knows to convert the selected JPEG images to bitmap files, but it doesn't know where to place the files after converting them. Choosing a directory to store the files is the final stage in this method of conversion.

19. Open the Save As box in the File menu and select the hard drive.

20. Double click on the hard drive folder in the Directories box to open up the root directory.

21. Move through the directories to the directory chosen or created at the start of this exercise for storing the bitmap files.

22. The name of the image file(s) can be changed at this stage by typing an alternative in the File Name box. Hijaak PRO 2 automatically places the bmp. extension at the end of the file.

23. Click on OK to close the Convert viewer. The files are converted to the bmp. format and saved in the chosen directory.

24. Open the File menu and click on Exit to close Hijaak PRO 2.0. Double clicking on the control menu button in the top left
hand corner of the window will also close this and other Windows applications.

The bitmap image files are now on the hard drive. The following procedure will open the images in Toolbook 3.0.

25. Open Multimedia Toolbook 3.0 by double clicking on the icon.

The keyboard F3 key toggles the interface between the softwares authoring and reading modes. The easiest way to determine which mode is active is to press F3 and observe the command bar at the top of the window; authoring mode has ten command menus and reading mode has only five.

A new Toolbook 3.0 book is created every time Toolbook 3.0 is accessed. New books contain one blank page and a background. The status bar in the bottom left hand corner of the Toolbook 3.0 window indicates which page of the book is currently active. In this instance the status bar should have the number 1 in it.

26. To begin the process of opening the bitmap images on this page, open the File menu.

27. Click on Import Graphic.

28. Move the cursor over the File Name box so that it changes to an I beam and click in the box to create an insertion point.

29. Type in the path name of the file to be imported.
30. Click OK and the requested bitmap file is imported onto the active page of the Toolbook 3.0 book.

Method 2. Importing Photo CD Images into Toolbook 3.0

Unlike JPEG files, PCD files can be imported into Toolbook 3.0 without conversion. Offsetting the direct importation advantage is the fact that the middle resolution PCD files are about five times larger than the JPEG files used here; they cannot be stored on a single CD-ROM. However at about one megabyte each, the PCD files are no larger than the bitmap files, to which the JPEG files have to be converted.

1. Insert the Photo CD into the CD-ROM drive.
2. Open multimedia Toolbook 3.0
3. Open the File menu.
4. Click on Import from Photo CD.
5. In the viewer that opens up, click on CD Drive and select the CD-ROM drive. A thumbnail sketch of the first Photo CD image appears in a preview window.
6. Open the Colour drop down box and select 16 million colours.
7. Open the Size drop down box and select the desired resolution. The following resolutions import into Toolbook 3.0 with this computer system: 128x192, 256x384, and 512x768.
7. Click on *Load All* to stack thumbnails of all the images into the Import viewer.

8. To import the desired image into the Toolbook 3.0 page, scroll through the image files using the arrows at the bottom of the viewer, select the desired image by clicking on it and then click on *Import*. More than one image can be selected and imported.

**Image Manipulation in Toolbook 3.0**

Images can be relocated and resized quickly and easily in Toolbook 3.0

1. After the image is imported it is the focus of the Authoring mode's attention; it is selected. Selected Toolbook 3.0 objects are surrounded by selection handles.

2. Selected items can be moved anywhere on the page by dragging and dropping them to a new location.

3. Objects are resized by dragging their selection handles. Once a selected item is in the desired location it can be deselected by clicking outside it anywhere in the Toolbook 3.0 page.

4. To re-select an image (or any other Toolbook 3.0 object), click on the *Select tool* in the Tool Palette. Objects that are clicked when the Select tool is active become selected.
Record Fields

Record Fields are rectangular Toolbook 3.0 objects that have the capability of holding text. Once generated in a background, Record Fields appear in the same position on every page associated with that background. The constant position of Record Fields lends continuity to a presentation. Record Fields, like other Toolbook 3.0 objects, can only be selected when the page or background they were created in is active.

1. Move to the background of the active page by clicking on the Background icon.
2. Click on the Record Field tool in the Tool Palette.
3. When the Record Field tool is active, the mouse cursor changes to a + sign as it is moved outside the Tool Palette. To draw a Record Field of the desired dimensions and location, click at the site of one corner and drag the mouse cursor to the diametrically opposing corner.
4. If a mistake is made, the record field can be relocated and resized as per other Toolbook 3.0 objects, using the drag and drop technique.
5. Deleting a Record Field is the same as deleting any other Toolbook 3.0 object: select it and hit the delete key.

Background Colours

At any time during the creation of a presentation the colour of the background can be changed. Like a Record Field, a
Background Colour appears on all pages common to that background.

1. To select a Background Colour, open the Object menu.
2. Click on Background Properties to open a Background viewer.
3. Click on the Colours option in the Background properties.
4. Click on one of the coloured tiles in the colour palette to make a selection and click on OK to close the viewer. Toolbook 3.0 automatically chooses the "bucket" tool to apply the colour over all the background.

Page Specific Fields

Fields are similar to Record Fields in that they are capable of accepting text. Like Record Fields, Fields are only editable when the page or background they were created upon is active. Unlike Record Fields, Fields are only visible when the page they are created on is active.

1. Select the Field Tool from the Tool palette
2. When the mouse cursor is moved outside the Tool Palette it changes to a + sign. Click the cursor at the site of a field corner and drag it to the diametrically opposing corner

Entering text into Record Fields and Fields

In the following description, the term field encompasses both Record Fields and Fields
1. Insertion points for text entry are created by double clicking inside the boundaries of any field. Toolbook 3.0 automatically wraps the text as it is entered. The delete and enter keys can be used to manipulate the text as per a word-processor.

   Text can be entered into fields when both the Reader and Author modes are operational. In some situations it will be desirable to prevent text entry at the Reader level by setting the fields Typing Enabled property to false.

2. To set the Typing Enabled property to false, right click the mouse within the field to access the Field Property viewer. Deselect Typing enabled by clicking on this property and removing the arrow that precedes it.

3. Click outside the Field Property viewer to remove it. To ensure that Typing Enabled has been set to false toggle to the Reader mode with the F3 key and attempt to enter text. Repeat steps 2 and 3 if text can be entered into the field.

4. The font and size of text that has been entered into fields can be altered in the Author mode. Select text by dragging the mouse cursor over it. Open up the Text menu and choose Character. Text can be altered to any of the options available in the Character viewer. The sample box in the Character viewer
provides an example of how the text will look if the selections are applied. To apply appropriate options click on OK.

Applying Colours to Record Fields and other Toolbook 3.0 Objects
1. Select the object to be coloured
2. Open the Colour Palette and select the bucket application tool.
3. Click in one of the coloured tiles in the Colour Palette. When the tile is clicked, Toolbook 3.0 fills the Object with that colour.
4. The "paintbrush" tool applies coloured borders around the selected objects. This tool also dictates the colour of Field text. To apply a coloured border to a Record Field, simply click on the paintbrush tool and select one of the coloured tiles.
5. To change the fill and border colours of objects repeat the above process and select a different coloured tile from the Colour Palette.

Creating a New Page
1. Click on New Page in the Object menu.
2. When New background is selected from the Object menu, Toolbook 3.0 generates a new page and a new background.
Naming Pages

1. From the Edit menu, select Page.
2. Click on the Properties icon.
3. Type a name for the page in the Name box of the Page Properties viewer that appears. Toolbook 3.0 is case specific, keeping object names as either upper or lower case can make scripting easier.
4. Click on OK to close the viewer.

Making Navigation Buttons

1. Select the Push Button tool from the Tool Palette.
2. Push Buttons are drawn in the same way as Fields, by dragging the mouse cursor between diametrically opposing corners.
3. The appearance of presentations is improved if navigational buttons are the same size. Identical buttons are easily produced by copying and pasting a button of desirable dimensions. Buttons, like other Toolbook 3.0 objects have to be selected before they can be copied. When a button is selected, click on Copy from the Edit menu, Toolbook 3.0 copies the button to the clipboard.
4. To paste button copies, select Paste from the Edit menu. The copy is pasted on top of the original button and is selected. Click within the selected button and drag it to the desired position. The same method can be used to copy and paste other Toolbook 3.0 objects.
5. The buttons have to be given captions so that users know where they navigate to. Captions are the letters that appear on a button. Toolbook 3.0 places the default caption "Button" on Push Button's as they are created. One way to set a button's caption is to access its Properties viewer and type a caption in the Caption option. To access the Properties viewer, select the button and click on the Properties icon. With the Properties viewer open, type a caption into the Caption box.

Navigation buttons need a script that tells Toolbook 3.0 what to do when they are clicked in the Reader mode. Toolbook 3.0's scripting language is called Openscript. All the scripts needed for these presentations are very short and are provided in the next section; they do not function in Author mode.

6. To access the scripting page of any object, click on the Script button in the Properties viewer. After the script has been entered, click on the Update and Compile icon, then click on OK to close the Properties viewer. The button's caption and function are now set.

Creating a Presentation

Only the Toolbook 3.0 features described above are needed to create a professional looking presentation. For presentations only
one page in length, an image(s) and a field could be placed on the same page together. Most presentations will consist of: several pages, one or more backgrounds, page specific images, a single Record Field containing text pertinent to the images and page specific Fields. The following text describes one of the quickest ways to develop a presentation.

1. Open Toolbook 3.0
2. The first page should be called, start
3. Go to the background of the page and give the presentation a colour
4. Create two buttons and a field on the page. The field will contain the title of the presentation and the buttons will contain the following captions, Continue and Exit. Place the buttons side by side in a corner of the page with the exit button on the right. The script for the Continue button should read-

    to handle buttonClick
    transition "dissolve" to page "first"
    end

Any error in a script, will prevent the presentation from working. Extreme care has to be taken. Fortunately Toolbook 3.0 has a script editor which provides error messages when the
Update and Compile icon is pressed. If an error message is received recheck the script and change it so that it matches the examples.

The script for the exit button should read
to handle buttonClick
    set sysSuspendMessages to true
    send exit break to system
end

5. Create a new background and give it a colour. Place a Record Field in this background. The Record Field should be large enough to accommodate all the text associated with the images, but not so large that images cannot be placed next to it. Some experimentation may be needed to get the Record Field to the correct size. At the beginning of presentation development it is easier to guess the size of the Record Field; it can always be resized as the project develops.

6. Five navigation buttons have to be entered in the new background. They should be identical, and arranged in a bank. For convenience the navigation button banks should be placed in a corner of the background. The captions of the buttons should read: Start, First, Prev, Next, and Last.
7. Enter the following scripts into the: Start, First, Prev, Next and Last buttons

-Start button
to handle buttonClick

transition "dissolve" to page "start"
end

-First button
to handle buttonClick

transition "dissolve" to page "first"
end

-Prev button
to handle buttonClick

if this page <> page "first"

transition "dissolve" to previous page
else

request "This is the first page" with "Click here"

end if
end

-Next button
to handle buttonClick

if this page <> page "last"

transition "dissolve" to page "last"
else

request "This is the last page" with "Click here"
end if
end
-Last button
to handle buttonClick

transition "dissolve" to page "last"
end

8. Go to the page level and call the second page of the book, first. Import an image and move it to an appropriate position on the page. Text can now be added to the Record Field and any page specific Fields. Add subsequent pages to the presentation as required. The name of the last page must be, last.

Accessing the Fox Pro Data Base

Neither Toolbook 3.0 nor PowerPoint 4.0 can access the FoxPro data base files. To access the Fox Pro data base files and the JPEG files simultaneously, Mr. David Walker of McMaster University's Computer Science department created a control panel in Toolbook 3.0. The control panel defines access to the data base files.

Gaining access to the data base from Toolbook 3.0 involves the use of two data base connection utilities. The data base connections work rather like device drivers making the data base files understandable: first to the Windows 3.1 operating system, and second to Toolbook 3.0. Microsoft's ODBC (Open Data Base
Connection) makes the data base compatible with Windows 3.1 and Asymetrix's TDBC (Toolbook Data Base Connection) interfaces with Windows 3.1. The Fox Pro data base files are read through Paradox, another data base.

When a file is requested from the control panel, TDBC reads the Paradox drivers which in turn read the Fox Pro drivers making the file accessible to Toolbook 3.0. The data base is on the hard drive but it could be incorporated onto the CD-ROM along with the JPEG files. When a request is made to view an entry, the control panel accesses the data base and corresponding bitmap files.

Not being able to access the Fox Pro data base is not an insurmountable problem. One solution would be to incorporate the data base and control panel onto the CD-ROM. A slower but longer term solution would be for professors to provide students with appropriate identifying information as work is assigned. Over time all the images will be utilized and the information on the data base will be transferred to the presentations. The latter solution is preferable as information associated with new images can be incorporated into the presentation format directly and the limited accessibility of the Fox Pro data base is avoided.
Chapter four
Microsoft PowerPoint 4.0

PowerPoint 4.0 and Presentations

PowerPoint 4.0 is a software package specifically designed for creating presentations; it is not as versatile as Toolbook 3.0. On the plus side, PowerPoint 4.0 is easy to learn and does not require programming skills. The interface created with Toolbook 3.0, permits the presentation of images and accompanying text on the same page which meets the needs of the proposed education system. PowerPoint 4.0 slides can be made to resemble the Toolbook 3.0 interface. Instead of book pages, presentation slides are created with PowerPoint 4.0. As with Toolbook 3.0 books, new PowerPoint 4.0 presentations can be appended at any time after their creation.

PowerPoint 4.0 presentations were investigated for the same reason as the Toolbook 3.0 books; to determine their feasibility for a system where students teach themselves as they create and present their products to the class. The main advantage PowerPoint 4.0 has over Toolbook 3.0 is that students do not have to learn a scripting language to create presentations of a similar quality. The Toolbook 3.0 scripts that are needed to create these presentations are very simple and could probably be

34
explained in about twenty minutes. More complicated effects could require more computer knowledge than would be reasonable for a twelve week course. The presentations created in both Toolbook 3.0 and PowerPoint 4.0 have a professional look, that is they are aesthetically appealing and smooth running. A separate application called PowerPoint Viewer comes with PowerPoint 4.0 and can be used to show presentations. PowerPoint Viewer means that expensive software does not have to be installed on every machine used to demonstrate presentations. Both PowerPoint 4.0 and Toolbook 3.0 share the impediment of being unable to handle JPEG files. Bitmap images are used throughout this description.

The following description familiarizes the user with PowerPoint 4.0 as quickly as possible. Time limitations in twelve week long university courses mean that learning the software has to be made as simple as possible. In keeping with the need for simplicity, information is not provided on every nuance of the software. The goal is to provide students with the skills to produce presentations in the shortest time possible. The same approach was used with Toolbook 3.0.

To increase the clarity of the following description, italics are used where necessary to emphasize the actions a user needs to perform. When creating PowerPoint 4.0 or Toolbook 3.0
presentations, the *Save functions in the File* command menus should be used frequently.

Creating Presentations with PowerPoint 4.0

The *AutoContent Wizard*

1. Open the software.
2. Click on *AutoContent Wizard* to start the first of four presentation creation steps.
3. Step 1 simply involves reading the background information in the AutoContent Wizard and then clicking on the *Next* button to go to step two. Navigation between the four Wizard steps is possible at any time using the *Next* and *Back* buttons.
4. Step two makes the title slide, which is the first slide of the presentation. Appropriate answers have to be typed to three questions.
   i. What are you going to talk about?
   ii. What is your name?
   iii. What other information would you like to include?

When a presentation is shown, the answers provided to the three questions appear as titles on the title slide (the first slide). The answers also appear at the bottom of all the other slides.

5. In Step 3, select the *Training* option as it is the most useful format for the required presentations. When Training is
selected the prompts for a PowerPoint 4.0 Training presentation appear in a large box at the left of the active window.

6. To complete Step 4, click on Finish to close the AutoContent Wizard. PowerPoint 4.0 creates nine slides for a training presentation. When the AutoContent wizard closes the slides are made visible in a viewing mode called Outline view. Prescriptive prompts for creating presentations are on the nine training slides. Replacing the prompts with relevant information should result in coordinated presentations.

7. Close the Cue Cards window; it can be re-accessed at any time from the Help menu.

The PowerPoint 4.0 Interface

When the mouse cursor is positioned over any icon on the screen, a yellow rectangle containing the name of the icon appears. Ascertaining icon names is a quick way of becoming familiar with some of PowerPoint 4.0's capabilities. The icon names are very descriptive. There is a Help icon on the right side of the Standard toolbar which contains a black arrow and a blue question mark. When this icon is clicked, a black question mark becomes associated with the mouse cursor. Clicking on icons in this context sensitive help mode activates an information viewer that explains the function of the icon clicked. To close a viewer, double click inside the Control-menu box.
8. Open the Slide view mode using the bank of viewing mode icons atop the status bar. Unless the text was altered in Outline view the first slide will appear. This slide contains the text previously seen to the right of the number 1 in Outline view.

9. If the first slide does not appear, drag the elevator on the right of the viewing mode, upwards as far as it will go. Just like icon names, slide numbers appear on the screen as the elevator is dragged. Releasing the mouse button when Slide 1 appears makes the first slide visible and active. Other slides can be made active by dragging the elevator to appropriate positions.

Other Viewing Modes

10. When the Slide Show view icon is clicked, PowerPoint 4.0 changes to a viewing mode where the active slide fills the screen.

11. Clicking the left mouse button anywhere on the screen moves the presentation onto the next slide. Another simple way to navigate through a presentation is to use the right and left keyboard arrows. The right arrow goes forward through a presentation one slide at a time, and the left arrow shifts the focus toward the presentation's beginning. A third way of navigating through a slide show is to use the keyboard numbers. For example, pressing number 9 followed by the Enter key makes the ninth slide active. The third navigational technique only
works after the presentation has been saved. Navigation through Slide Show view has been described in detail as this is the viewing mode used to demonstrate finished presentations.

12. Each slide shown in Slide Show view contains an annotation icon. Clicking on the pencil inside the Annotation icon toggles the function on and off. Annotation is useful for highlighting during a presentation. To annotate, simply hold down the left mouse button and drag the mouse cursor over the area in question. Annotations only exist while a slide is active, they can even be erased when the slide is active using the E key. A slide show can be terminated at any time using the escape (Esc) key.

13. When the Slide Sorter view icon is clicked, small versions of all the training slides appear on the screen at once. The active slide is the one surrounded by a black border. Other slides are made active by clicking in them or by using the keyboard arrows to move the black border. Double clicking within a slide makes it active and changes the viewing mode to Slide view.

14. The order of slides can be changed in Slide Sorter view by dragging selected slides to a new location. To help with placement, a slide icon and a vertical line appear as the slide is dragged. Slides are placed to the right of the vertical line when they are dropped.
15. Surplus slides can be deleted in Slide Sorter view by hitting the Delete key when the slide is active. Active slides can also be deleted with the Delete option in the Edit menu. The Edit menu delete option also works in Slide view, Notes Pages view and Outline view.

Creating a Look for the Slides

Presentation Templates

PowerPoint 4.0 comes with over a hundred colour templates. Applying a template can enhance the aesthetic appeal of a presentation considerably. A template can be applied to individual slides or to a complete presentation. When a training presentation is created with the AutoContent Wizard, a default template is applied to all the slides and the Slide Master. The Slide Master is an editable slide, whose layout and text characteristics are applied to all the slides of a presentation. The Slide Master default text style, colour and font varies from template to template.

If a colour template is to be applied to most of the slides, it should be applied before the Slide Master's text is manipulated. Applying a template after the Slide Master has been fine tuned overrides the work done on the Slide Master. The Slide Master on the other hand can be altered at any time without affecting the template. Although the layout of the slides can be
fine tuned in the Slide Master, this is only useful when all or many of the slides have the same layout. Presentations can and do contain several different slide layouts.

16. Presentation templates can be accessed by clicking on Presentation Template from the Format command menu. When the C:\powerpnt\template\slideshow directory is active, PowerPoint 4.0 template files are listed in the File Name dialog box. Selected template files appear in a preview box in the Presentation Template window. Some experimentation may be needed to locate an appropriate file. Clicking on Apply incorporates a template into a presentation. PowerPoint 4.0 returns to the viewing mode the Presentation Template was accessed from; if this viewing mode provides a view of the slides, the effect of the template can be seen. Other templates are easily selected and applied. It is a good idea to spend some time ensuring an appropriate selection has been made.

Although it can be time consuming if the Slide Master has been set, templates can be changed at any time during the creation of a presentation. A more productive approach is to choose a template at the start of presentation development and then set the Slide Master. Different templates can be applied to individual slides when they are active in Slide Sorter view. The same PowerPoint 4.0 functions are used as described above.
The Slide Master

17. Click on the Master option in the View command menu to access the Slide, Outline, Handout and Notes masters. Masters are rather like the backgrounds of Toolbook 3.0 in that selections made for them appear on all the slides. Click on Slide to open the Slide Master.

18. When the Slide Master is active on the PowerPoint 4.0 interface, the text characteristics can be altered. Clicking in the Master Title text placeholder creates a text insertion point and a border of hatched lines to indicate the placeholder is selected. The Master Title Text placeholder is at the top of the Master and contains the following text "Click to Edit Master Title Style". With the Master Title Text placeholder selected, different fonts can be assessed from the Font option in the Format command menu.

The text colour can also be selected in the Format/Font option by clicking on Colour. The palette which opens up has been chosen by professionals to complement the template. Different palettes are opened for different templates. A colour is selected by clicking one of the palette blocks. More text colours can be accessed or created by clicking on More Colours; but this is an area that is best left to those with an artistic bent. To install the font type and size, colour and case choices, click on OK in the Font viewer.
19. With some templates a border can be added to the Master title text to improve the aesthetics. With the Master Title text placeholder active, open the Format command menu and click on Colors and Lines. Compose a border by selecting a line style and colour from the Line drop down box. Colours to fill the title text area can be selected at this juncture by opening the Fill drop down box. If needed, shaded and pattern options for the title text placeholder are available in the Fill drop down box. Clicking on OK closes the Colors and Lines option and applies the selections to the Master Title text placeholder.

Coloured borders can be applied to other objects created in, or imported into PowerPoint 4.0. The process is the same as creating a border for the Master Title text placeholder.

20. Font options, border, fill colour, shade and patterns can also be added to the Master text placeholder of the Slide Master (the placeholder beneath the Master Title text placeholder). The Master text placeholder contains several text levels whose font decreases in size as the text level declines. Varying the font size in text levels is meant to symbolize the varying importance of different concepts to a presentation. Many slides will not need all the text levels. The appearance of individual text levels can be manipulated to suit the presentation. Clicking within the Master text placeholder makes this area active. When the cursor is moved over one of the bullets to the left of a text level it
changes to a cross. Clicking the left mouse button when the cursor is a cross selects the text level associated with that bullet, as well as all the text levels beneath it. The font, size and colour of the text can then be altered as per the Master Title text. Individual text levels are selected by clicking within them. Text levels do not become highlighted when selected individually, but font and colour alterations are applied to them.

21. PowerPoint 4.0 offers many options for the bullets in the Master text placeholder. Bullets are altered by selecting their text level and accessing the Bullet option in the Format command menu. Appropriate choices for the size, colour and type of bullet are made from drop down menus in the bullet viewer.

22. Selected text levels can be realigned using the Alignment option in the Format command menu. The available choices are Left, Centre, Right or Justify. Remember, options made in the Slide Master regarding text, fill colours, shading, etcetera will be applied to all the slides; these choices may not be suitable for all the slides. Text characteristic options for individual slides are made when the slides are active.

23. Page number and date options for the slides are inserted when the Slide Master is active. Click on Date from the Insert menu and a box containing a // symbol is inserted in the Slide master. Page numbers are inserted onto the Slide master by
clicking on **Page Number** in the **Insert menu**. PowerPoint 4.0 places the Page Number symbol (##) next to the date symbol. Clicking within the date box replaces the selection handles with hatched lines. At this stage the date can be dragged to any position on the Slide master using the hatched lines. The page number can be moved with the same technique.

24. Select Slide Show view to ensure that the template and text choices are satisfactory.

**Transition and Build Effects**

25. Another powerful option available in PowerPoint 4.0 is the **Transition Effect**. Transition effects determine the manner in which a slide becomes visible in Slide Show view. Slide Sorter view has to be operative for transition effects to be applied. Clicking on the **Transition box** in Slide Sorter view opens a combo box containing a number of transition effects. No Transition is the default transition effect. When a transition is selected, its name replaces the No Transition option in the combo box and it is applied to the active slide. The transition effect can be seen most easily by going to Slide Show view when the slide is active.

26. The fastest way to apply a transition effect to all the slides is to shift click them all before picking an effect from the Transition combo box.
27. Build Effects and transition effects share the same selection method except that the Build rather than the Transition box is used in Slide Sorter view. Build effects cause slides to open up in Slide Show view with just the title visible. Clicking the mouse causes the text associated with the first bullet to fly onto the slide from the left, right, top or bottom depending on the build effect selected. Successive mouse clicks build up the slide, bullet by bullet, until all the text is on the screen. The next mouse click moves the slide show onto the next slide.

Build effects are especially suited as a highlighting mechanism for the title slide as this is usually where the main points of a presentation are introduced. Transition and build effects are changed in Slide Sorter view by making different selections from the combo boxes. Some experimentation with these effects may be necessary for optimal presentation of a particular concept.

The Notes Master

PowerPoint 4.0 can be used to print notes pages to accompany the slides. The notes pages also have a master that should be worked on after the template is applied. The Notes Master window consists of electronic foolscap beneath the slides; it is accessed from the Master option in the View command menu.
28. Open the Notes Master and make the slide portion active by clicking inside it. The slide is surrounded by selection handles when it is active. If the mouse cursor is moved to a corner of the slide it changes to a double sided arrow. With the cursor in this state, the slide can be resized using the drag and drop technique.

29. The notes section can also be resized by the drag and drop technique, but it has to be double clicked before it is selected. Changing the look of a notes page may be necessary for aesthetic purposes once information has been entered. If the amount of information associated with each slide varies considerably, it may be more productive to alter notes pages individually in Notes Pages view. Resizing techniques are the same in Notes Pages view as for the Notes Master.

30. When the Notes Master is accessed the text is set to 33 percent of the print out size. However, it is easier to work in the notes section of the Notes Master by setting the Zoom control to 75% or 100% of the final print out size.

31. Text levels are manipulated in the Notes Master in the same way as for the Slide Master.

The above steps explain most of the functions the user has to be familiar with to create a slide show. The next section is concerned with entering the content of the presentation onto the slides and notes pages.
Adding Text to the Presentation

32. Make sure the title slide is active and go to Slide view. Altering the text of this or any other slide is a simple matter of creating an insertion point anywhere between the bullet and the end of a text segment. Text can then be manipulated as per a word processor.

33. Go to the second slide, remove the prompts and enter the data for the presentation. The usefulness of the prompts is more apparent now. It may be necessary to delete extraneous prompts for some presentations.

Adding Images to the Presentation

Before adding an image to a slide ensure that no part of the slide is selected. Click outside PowerPoint 4.0 objects to de-select them. If an object is selected when an image is imported, PowerPoint 4.0 fills the object with the image.

34. Click on Picture from the Insert menu and navigate through the directories until the bitmap file appears in the File box. Select the file and click on OK in the Insert Picture viewer. PowerPoint 4.0 places the image on top of the slide. The image is preselected and can be positioned and resized as per other PowerPoint 4.0 objects.
Generating and Deleting Slides

35. To delete a surplus slide, make sure the slide is active and select *Delete Slide* from the *Insert* menu.

36. When the *New Slide* button is clicked in the bottom right hand corner of the window, a New Slide Layout viewer pops up. Click in one of the layout graphics to select it. The name of the selected viewer appears in a field on the bottom right hand side of the viewer. Click on OK in the viewer and PowerPoint 4.0 places a new slide with the desired format in the PowerPoint 4.0 window. The new slide is placed after the slide that was active when the New Slide function was accessed. PowerPoint 4.0 automatically alters the numbering of the slides. The slide format produced by the AutoContent Wizard is the Bulleted List option.

37. With a new slide, text is entered into the Title text area as before, but text levels have to be created individually using the Font style, size and colour functions in the Format menu.

38. When the slides are complete, text can be entered into the text area of the Notes Pages.

39. To print the notes pages use the *Print function* in the *File* menu. Open up the *Print What* combo box and select *Notes Pages*, before clicking the OK button.
Showing the Presentations using PowerPoint 4.0 Viewer

PowerPoint 4.0 comes in Macintosh and P.C. compatible versions.
PowerPoint Viewer comes on a single diskette and can be installed on any Macintosh or I.B.M. compatible P.C. depending on it's compatibility. To install and use PowerPoint Viewer with an I.B.M. compatible:

1. Insert the diskette and go File/Run in the Program Manager.
2. Type: the drive letter\setup.
3. Open the software.
4. Type the name of the file in the File Name box or navigate to the file in the Directories box.
5. Click on Show.

To use PowerPoint viewer on a Macintosh; insert the diskette and double click on the icon that appears on the monitor. Navigate to the file and click on Show.
Chapter five

The Effectiveness of Multimedia

A major problem with computers is the speed of technological change. Before new hardware and software products are introduced, newsflashes tell us that developments with even greater potential are only months away from release. This situation creates a consumer quandary. It is no longer sufficient to make a purchase with the assumption that an upgrade will be necessary in a few years. Today's consumer has to sift through a maze of innovative change and determine if a product will even play on the computer platforms of tomorrow.

The effect of the on-going technological revolution cannot have been restricted to consumers; it must have placed enormous pressure on educational researchers and instructors as well. Not too long ago the speed of technological change was slow enough that products could be thoroughly examined. Once examinations were complete, educational institutions could be advised whether to invest in the technology or not. The current pace of change makes a complete analysis of every innovation an impossibility.

Today, there are many innovative programs in every area of education. In fact, the prevalence of experimental programs in North America is now such that their number is unknown (Fullan
and Stiegelbauer 1991). The large number of programs adds to the complication associated with technological change, as do the numerous advances in our understanding of the learning process. Unfortunately we are only just beginning to relate learning to the accompanying changes that occur in the brain. The confusion will continue as long as definitive theories of learning, and instruction elude us (Megarry, 1988).

Schools have concentrated on revamping the traditional tools of education. They already lag behind industry's use of technology by several decades (Mecklenberger, 1990) as cited by Adams and Bailey (1993). Adams and Bailey (1993) claim that the U.S. education system has failed to meet desired outcomes because it has concentrated on didactics. Proposals to involve information technologies (computers, video and telecommunications) in the restructuring of schools are a recent phenomenon (Adams and Bailey, 1993). Calling for a shift to information technology however, does not resolve the issue of how to incorporate it efficiently and productively. Although many people feel that technologies such as computer based instruction (CBI) and multimedia (MM) are an educational boon, no one knows how to use them in an effective way, in every situation. Not everyone feels that CBI and MM are pedagogically advantageous; some researchers such as Clark (1994) even question whether media have any effect on the learning process.
In higher education, computer assisted instruction (CAI), computer managed instruction (CMI), and computer enriched instruction (CEI) make similar contributions to student learning (Kulik and Kulik, 1991). As the effects of CAI, CMI and CEI are similar, they are not distinguished in this work and CBI is used to describe them collectively. The similarities between Interactive Videodisc (IVD) and MM are sufficient that findings for IVD are considered likely to apply to MM CD-ROM. Both technologies rely on video and communication between the student and the software. Usually, this communication occurs through the keyboard. So the latter assumption is not unreasonable; in his meta-analysis of IVD, Fletcher (1990) contends that his results should apply to any system with the same functionalities.

In the late 1960's, comparisons between CBI and the traditional Socratic teaching style started to appear in the literature. Generally, comparison research involves two groups; the experimental group is subjected to an innovative program, and the control group is taught the same material with conventional Socratic techniques. Effect sizes are used to quantify the difference in performance of CBI and conventional education. Usually, effect size is calculated as the difference between the mean examination performance of the two groups. The difference is then divided by the control group's standard
deviation. The larger the effect size, the better the experimental method of instruction.

Government funding of comparison research has yielded a body of work so large that it is pointless to try to judge all CBI programs from a single study. Meta-analyses on the other hand are an excellent source of information as they provide a broad perspective of the issue (Kulik and Kulik, 1991). Several meta-analyses are reviewed here to help determine the effectiveness of CBI. Here the meta-analytical review and other literature are used to investigate the validity of claims for MM. The results of the investigation are used to help determine if a move to a computer based, self education system is justified.

Proponents of multimedia claim that it can be used to provide: effective, motivating, and individualized instruction on any topic. It is also claimed that multimedia will be affordable by Western standards.

Nichol, Liebhold, and Kachler (1987) state that 'Their (multimedia's) linking capabilities invite individually customized and inquiry driven approaches to knowledge acquisition. Their interactivity encourages problem solving activities. And their capacity for vast storage and quick retrieval puts whole domains of knowledge within reach. Potentially they become the tools that enable
people to learn in a most meaningful and effective way-by discovery" (p. 327).

Gates (1993) claims that "Multimedia computing, then is a powerful tool for education to use to develop lessons and materials. It is especially useful for the subjects that are hardest to teach and most difficult for students to learn, because it uses the media that teach those concepts most effectively" (p. 37)

Megarry (1988) states "The convergence of computing and compact disc technologies is about to produce an all-digital, interactive, compact multimedia learning medium. It will also, by Western standards, be affordable, ultimately even cheap" (p. 173).

Sweeters (1994) declares 'who wouldn't prefer to see and hear a volcano erupt rather than simply read about it? Who wouldn't be more interested in learning about a new company policy after viewing a "live" clip of the CEO emphasizing its importance? Almost any presentation can be made more interesting by using hypermedia" (p. 49)

No doubt some of the claims for MM derive from vested interests of the authors. A closer look at what we know about the cost of education, student motivation and individualized instruction reveals that claims for MM are hard to verify. In the
next section, the claims of Nichol et al. (1987), Gates (1993),
Megarry (1988) and Sweeters (1994) are critically examined.

Multimedia and the Cost of Education

Initial investment in information technologies will not be
inexpensive (Adams and Bailey 1993). However, investment in
information technology may be unavoidable as both Ehrmann (1995)
and Adams and Bailey (1993) contend that effective schools of the
near future will have to rely on it heavily to maintain
enrollment after age sixteen. A litany of traditional education's
shortcomings is provided by these workers: learners no longer
connect with it; it's learning outcomes are unknown; grades do
not relate to success in life; it lacks the potential
accessibility of information technology; and it is becoming
increasingly expensive. According to Adams and Bailey (1993) and
Ehrmann (1995), information technologies are the logical choice for
replacing traditional Socratic education techniques as they:
overcome the inadequacies of traditional education, reflect the
electronic world we live in and permit the pursuit of an
individually relevant education (Adams and Bailey, 1993; Ehrmann,
1995).

In a meta-analysis of IVD instruction in military training,
Fletcher (1990) found eight studies that investigated cost
effectiveness. Although eight studies is too few a number to give
reliable averages, it is interesting that they all found IVD to be more cost effective than conventional education. Sometimes, videodisc systems were just cheaper than the actual equipment that would have to be bought if video simulations were not available. In other cases IVD had greater start up costs, but the low cost of additional equipment and software meant that the break-even point was soon reached.

Ehrmann (1995) argues that we cannot and should not be concerned with the cost of different education systems. The reasoning is that the determination of normal costs and benefits is absurd when so many teaching methods of differing efficiencies are used in colleges. Besides this reasoning, determination of educational efficiency must also be impeded by the random exposure of individual learning styles to the different teaching methods. Any truly accurate estimate of current teaching efficiency in colleges would have to account for chance encounters between teaching methods and learning styles. The difficulty of this task is not inconsiderable.

Citing the work of Pascarella and Terenzini (1991), Ehrmann (1995) notes that graduating from college influenced a life's outcomes, but the correlation between grades and work achievement is too small to be meaningful. To Ehrmann (1995), the lack of correspondence between grades and work achievement implies that the wrong things are being taught. If the knowledge
education imparts is inappropriate, it does not matter if CBI is a more efficient method of instruction. Unless the curriculum includes meaningful objectives, increased efficiency is useless.

Ehrmann (1995) does not mean to imply that assessing information technologies is inappropriate; rather he questions the validity of traditional comparison research. Ehrmann would prefer we acknowledge that traditional comparisons are passe, and concentrate instead on determining what makes for effective education. He would contend that cost comparisons are only worthwhile when the components of effective education are known.

It could be argued that the impact MM and other information technologies have had on society is now so great that proving their cost effectiveness is no longer important. Certainly the mere use of these technologies can facilitate students entry into a computerized society. It could be argued that use of information technologies is more relevant to the communication methods used in society today than traditional Socratic education. Adams and Bailey (1993) argued that the use of MM simply to reflect a technological society is justifiable. A trickier question that Adams and Bailey (1993) did not contend with, is how much expenditure is justifiable in the absence of proven cost effectiveness.
Reduced Instruction time, Better Marks, Increased Motivation and Interactivity

Comparison research sheds little light on the cost and effectiveness of education, but more tangible issues such as instruction time and examination performance have proved easier to handle. Kulik and Kulik (1991) report that between 1966 and 1984, student performance on CBI courses improved progressively. The improvements were attributed to the increasing sophistication of computer technology.

Curious to see if microcomputer technology had increased the performance of CBI still further, Kulik and Kulik (1991) performed a comprehensive meta-analysis of comparison research. The 1991 analysis revealed that the time trend had been misleading; recent CBI programs performed no better than earlier ones. The typical CBI program increased examination performance by about 0.30 standard deviations (Kulik and Kulik, 1987; Kulik and Kulik, 1991).

Kulik, Kulik and Cohen (1980) note that many reports attest to the effectiveness of CBI at the elementary level, but the results for higher education have been less conclusive. In a meta-analysis of comparison research in higher education, Kulik, Kulik and Cohen (1993) found that CBI improved examination performance in thirty seven of fifty four studies. In studies where CBI generated improvements, every level of student ability
was impacted positively. In thirteen studies, CBI resulted in significantly improved performance. One study significantly favoured conventional instruction. Typically, marks increased by about one quarter of a standard deviation. The exclusion of elementary programs from this meta-analysis could account for the improvement in examination performance being less than 0.3 standard deviations.

Fletcher (1993) examined IVD comparison literature of military and industrial training, as well as higher education. It was found that IVD increased student performance by 0.50 standard deviations. IVD performed much better in higher education than military training. The average student in higher education improved their examination performance by 0.69 standard deviations. Fletcher felt the lower performance of IVD in military training could be explained by different educational objectives in the two institutions. The goal of military education is to meet a minimum standard as fast as possible. In higher education, students are encouraged to repeat exercises and attain an excellent mark.

Besides improving examination performance, students cover required material faster when information technologies are used. On average, students using CBI or IVD, complete exercises thirty percent faster than students using conventional Socratic programs (Fletcher, 1990; Kulik, Kulik and Cohen, 1980; Kulik and Kulik, 1991).
Enthusiasm for CBI and IVD might seem justified given the reported improvements in examination performance and instruction time. However, any enthusiasm should be tempered by the fact that a number of factors influence comparison research. Kulik and Kulik (1991) maintain the following tend to be constant influences on comparison research: publication source, motivation, instructor effects, and study duration.

The publication source effect is one of the most common meta-analytical findings; it holds that published studies have stronger results than dissertations and unpublished studies Kulik and Kulik (1991). Surprisingly, in their study of higher education, Kulik, Kulik and Cohen (1980) found no correlation between publication source and result strength. Conversely, in a study of comparison literature at all educational levels, Kulik and Kulik (1991) reported a correlation between the publication source and the strength of results. Publication bias, that is, editors favoring statistical strength over study quality is a possible explanation for the publication source effect (Kulik and Kulik, 1991). Kulik and Kulik (1991) also proffer the different experience and professional status of journal and dissertation writers as an explanation for publication bias. Kulik, Kulik and Cohen (1980) gave no explanation for their finding that comparison literature in higher education was independent of publication source.
Kulik, Kulik and Cohen (1980), and Kulik and Kulik (1991) report that students tend to prefer CBI courses and become more interested in the subject matter. Potential sources of statistical bias for their student motivation results are provided by Kulik, Kulik and Cohen (1980). In this 1980 meta-analysis, Kulik, Kulik and Cohen gave equal weighting to individual reports. They note that if studies had been weighted according to the number of students involved, then the PLATO (Programmed Logic for Automatic Teaching Operators) and TICCIT (Time-shared, Interactive, Computer Controlled, Information Television) studies would have carried as much weight as all the other investigations combined. A size weighting such as this could have influenced the results considerably as student attitudes were only marginally influenced in the PLATO and TICCIT systems.

The difference between student performance on innovative and conventional courses is greater when the courses involve different teachers (Kulik and Kulik, 1991; Kulik, Kulik and Cohen, 1980). Kulik and Kulik (1991) provide two possible explanations for this effect. First, in cases where different teachers are involved, differences in student performance will be enhanced if stronger teachers are assigned to the CBI course. Second, in cases where the same teacher is involved, student performance differences will be minimized when involvement with CBI enhances teacher performance and the effect carries over into the conventional
course. Improvements seen in both courses when the same teacher is involved illustrate the importance of teaching method and teacher engagement. More research will be required to determine the true effectiveness of CBI in these situations.

CBI is more effective when the duration of the course is short. Typically, CBI courses that are four weeks long or less, improve student performance by 0.42 standard deviations; 0.16 standard deviations more than semester or year long CBI courses (Kulik and Kulik, 1991). Three possible explanations were submitted to explain the inverse relationship between course length and student performance.

A novelty or Hawthorne effect could explain CBI's greater success on short courses. With increasing course length, student performance approaches that of conventional courses as the novelty of the medium wanes. Failure to adjust tests to account for the different amounts of material covered in long and short term courses is another possible explanation. Finally the phenomenon could also be due to the tighter control that can be exercised in short experiments. Kulik and Kulik (1991) provided no evidence favouring one explanation over another. In fact, any combination of the explanations could impinge on the results obtained for course length and performance on CBI courses.

Fletcher (1990) found that IVD tutorials and simulations increase knowledge and performance outcomes equally. In addition,
Fletcher (1990) found that IVD tutorials were more productive than stand alone simulations. It seems reasonable to expect that a computer program that combined tutorial and simulation instruction would be more effective than a lone tutorial approach. Yet Fletcher (1990) found IVD tutorials were even more productive than computer programs that combined simulations with tutorials. No explanation was offered for this result except to note that the effect size found for IVD tutorials (0.70) was larger than effect sizes reported for tutorials using CBI. To Fletcher (1990), this implied that IVD is a superior platform for tutorials. Further investigation of this matter could provide interesting data.

Fletcher (1990) also investigated IVD interactivity. Five interactivity levels (0-IV) were recognized; the higher the level, the greater the interactivity. The different levels are listed below.

Level 0. A videodisc system intended for linear play without interruption.

Level 1. A videodisc system with still_freeze frame, picture stop, frame and chapter search, dual channel audio, but no programmable memory. All functions are intended to be initiated by manual inputs from the videodisc player's keypad. Picture stop and chapter stop are read from the videodisc.
Level 2. A videodisc system with on-board programmable memory. The videodisc player's memory is programmed from the videodisc or by manual entry from the player's keypad. Inputs are made from the keypad or from a device that emulates the keypad. Level 3. A videodisc system in which the videodisc player is interfaced to an external computer. The videodisc player acts as a computer peripheral with its function under the computer's control. Level 4. The player is interfaced to an external computer, the videodisc functions as a storage device for digital information and as the source of analog picture and sound. The video frames on the videodisc store digital data intended to be read and processed by the computer.

Problems arise in meta-analysis because different researchers use different scales for assessing interactivity (Fletcher, 1990). In general, the more interactive the disc the better the student performance. There were two notable anomalies however; Level II videodiscs were not as effective as conventional instruction and the variability of performance outcomes increased with increasing interactivity. Fletcher provided no explanations for the results associated with interactivity; it appears to be a poorly understood variable in need of further investigation.
For every variable other than interactivity Fletcher (1990) reported less variability of performance outcomes for experimental groups than control groups. Reduced variability implies that innate talent has less influence over performance outcomes. Therefore in situations in which minimum performance is required from all members of a group, IVD would be preferable to conventional instruction.

Only one of the reports considered by Fletcher (1990) analyzed time on task; it was found that IVD increased the time spent practicing a task by forty-five per cent. Interestingly, CBI courses have also been found to increase time on task, (Feldman, Schoenwald and Kane, 1989). Finally, four of the studies assessed by Fletcher (1990) assessed the impact of IVD on retention. IVD was found to have little impact on retention of knowledge or the ability to perform tasks.

Limitations to Meta-Analysis

Kulik, Kulik and Cohen (1980) caution that meta-analysis is a reflection of what has passed; very new innovations cannot be assessed, and undiscovered technologies cannot be alluded to. Successful meta-analysis requires a substantial body of research to be complete. Simply put, meta-analysis is not a predictive tool. Also, meta-analysis only works for frequently measured
parameters; it does not easily accommodate unique or infrequently measured parameters.

Other factors complicate meta-analysis: varying professionalism amongst the original workers, unavailability of raw data, and differences in the design and intent of individual studies. Raw data is needed for true accuracy, but it is not always available. In cases where raw data is absent, some meta-analysts use the reported statistics (Fletcher, 1990). Differences in the design and intent of individual comparisons means that outcome measures and statistical parameters vary. If the reported statistics do not fit the meta-analysis exactly, statistical manipulations may have to be used. Reservation may be called for when meta-analyses use statistical manipulations or data other than the raw data; it is not unreasonable to suggest that these practices could attenuate the accuracy of results.

The inherent limitations to meta-analysis do not vitiate it; it is still a valid statistical technique. The meta-analyses considered here synthesize results from hundreds of comparison studies. Although hundreds of studies represents only a fraction of the total comparison literature, the findings are representative of CBI, IVD and MM. Four meta-analyses, covering all levels of education were examined for this literature review (Fletcher, 1990; Kulik and Kulik, 1991; Kulik, Kulik and Cohen, 1979
and Kulik, Kulik and Cohen, 1980. A list of the findings is presented below:

1. CBI and IVD usually improve student performance.
2. CBI and IVD reduce instruction time by about a third.
3. CBI and IVD have a slight positive effect on student enjoyment of a course and the subject matter.
4. Student performance outcomes are less varied in CBI and IVD courses than in conventional courses.
5. The advantages of CBI and IVD are felt most when the course is short.
6. CBI tutorials result in better student performance than conventional tutorials and outcomes on IVD tutorials are superior to those of CBI tutorials.
8. IVD affects knowledge and skill performance outcomes equally.
9. IVD does not effect retention.

Future Research

The results are general in nature which is unfortunate because people expect and want precise answers from research today. Fortunately the findings do provide suggestions for the
direction of germane future research. The following list of potential research questions is not exhaustive, but most of the information required for expeditious implementation of MM would be contained in the answers. A review of still more meta-analyses could provide even more insight into future directions for research topics.

1. Why does student performance improve on some courses but not others? Is MM only suited to some subject matter, and if so which?
2. When a teacher improves student performance in both conventional and CBI courses, how do we accurately apportion aspects of improvement to the medium and the method?
3. Why do CBI and IVD reduce instruction time? Fletcher (1990) indicated a possible answer to questions two and three; he thought that the primary value of computerized instruction is that it is a more efficient means of information delivery. Even if greater efficiency is proved for these media, knowing why they are so will be key to duplicating the effect.
4. What is the relationship between student motivation, enjoyment of a course, time on task and performance outcomes?
5. Why is the differential between CBI and conventional education larger when the course is short?
6. Why are IVD tutorials superior to CBI tutorials in terms of student performance and why do desirable outcomes become more prevalent with increasing interactivity?

Justification for a MM System

Much of the comparison research is fueled, in large part, by the desire to prove the superiority of one mode of education. Computer companies would dearly like to see research prove the superiority of their wares. Other researchers would like to demonstrate that it is the method of instruction and not the medium that promotes learning. A meta-analysis of the methods of instruction used in comparison studies could settle the dispute. If one method was found to consistently result in superior performance regardless of the medium, then the method of instruction would be implicated as the learning promoter. On the other hand, proving a medium to be superior regardless of the method of instruction would indicate the greater importance of the medium. Ehrmann (1995) felt that the issue does not have to be resolved, combining information technologies with a proven method of instruction would satisfy both parties. This approach is taken in suggesting a route for developing the proposed self-education system in selected Biology courses at McMaster University.

Fletcher (1990) inadvertently emphasized the current dilemma, of computer companies and other proponents of MM. Fletcher found
IVD tutorials to be superior, and intuitively ascribed this finding to the combination of video, pictures and interactivity in this medium. Fletcher's intuition also suggested that video would have a powerful impact on memory and increase retention; which was not found to be the case. The fact is that though the claims for MM make intuitive sense, research findings do not always accord with our intuition. Furthermore, even when our intuition is confirmed we cannot say why. Explanations for the deviations from intuitive thinking may be found in the field of cognitive science as our understanding of the learning process increases. Until then we are limited to speculation and second guessing our instincts.

Many would like to see the claims of Nichol et al, Gates, Megarry, and Sweeters proven with certainty. Unfortunately, this literature review indicates that all we can say about MM at the moment is that it is a technology that provides excellent results on occasion. Until a comprehensive explanation of MM's impact on cognition is available, we will not be able to explain its successes, nor harness its potential with the frequency and accuracy we would like.

The meta-analyses considered here, found that CBI generally works both adequately and quickly. However, after consideration of their results, Kulik, Kulik and Cohen (1980) considered that CBI made only a limited contribution to higher education. Kulik,
Kulik and Cohen's enthusiasm for CBI in higher education was tempered by the superior results other researchers attained at the elementary level. Kulik, Kulik and Cohen (1979) reported larger effect sizes for the Keller Plan, which may have also contributed to their guarded enthusiasm. Unfortunately Kulik, Kulik and Cohen did not determine or consider the cause of the weaker results attained for CBI at higher educational levels. Possible explanations for the results are limitations of the medium and lack of regular use because students lack the knowledge or enthusiasm to use it.

Ehrmann (1995) notes that CBI has consistently reduced the amount of time students spent covering material and that such consistency has rarely been demonstrated for other methods of instruction. Despite the potential this research demonstrates, the pace of curricular change remains slow. Ehrmann (1995) considered the pace of change to be slow because faculty often have to work alone taking years to develop software. When the final product is available, the lengthy production time means that it is often outdated and rarely used. Insufficient use causes many innovative software packages to fade into oblivion.

The proposed system of self-education in the Biology Department of McMaster University, bypasses the problems of lengthy production times and insufficient use. Once the basic materials are arranged in a data base, many students, rather than
a lone faculty member can create the learning tool. Having many developers means that products can be produced in a single semester rather than years. The data base is unlikely to become outdated as its technical problems concern file format rather than ephemeral software and hardware. Appropriate file format conversions will make the data base available to many new software packages.

The meta-analytical review performed here, points to the possibility of greater educational efficiency if the knowledge needed to apply MM effectively is acquired. The flexibility of the proposed self education system means it could be an indirect opportunity to learn more about the circumstances that increase the efficiency of MM; that possibility warrants further investigation.

A number of studies investigated by Kulik, Kulik and Cohen (1980) reported dramatic improvements in student achievement and enjoyment using CBI. It did not escape this author's notice that these programs were potentially important. If a product proves to be successful it makes sense to find out why, so that the effect can be duplicated. By a similar reasoning, the failure of some CBI courses should be investigated if failure is to be avoided in the future. The proposed system would also provide a chance to determine more about student learning outcomes.
Ehrmann (1995) indicated that traditional education is teaching the wrong things because grades do not correlate to success in the workplace. It is unknown whether this course will provide students with the skills required for success in the workforce, because we do not know what the skills and workplaces may be. The meta-analyses demonstrate that MM and other information technologies result in faster learning and improved student performance outcomes. If this course helps us utilize MM effectively, at least we will probably have a new and efficient medium for teaching the most useful life skills whatever they may prove to be. Justification for the proposed system then, could simply be that it is an opportunity to learn more about the variables that effect MM. Perhaps a more compelling justification for the system, is the potential MM has for providing an education that is relevant to the unique needs and interests of individual students, and in tune with the electronic language of society.

This review has not debunked the claims made for MM; rather it has illustrated some of the difficulties associated with assessing their validity. In discussing the complexities of educational change, Fullan and Stiegelbauer (1994) attest to the importance of learning by doing. Rather than waiting for definitive answers to the unknowns associated with MM, it would be better to begin implementing computerized courses for
self-education and to learn by doing. The learning opportunities that will arise as the system evolves, should make the venture worthwhile.
Chapter six

A Proposed Development Strategy for the Biology Department's Self-Education System

Hypertext

Megarry (1988) maintains that "The role of the computer should be organizing and representing knowledge to give the user easy access and control" (p. 172). Computerized hypertext environments as described in this chapter, fulfill this role very well. The creator of hypertext, Theodor Nelson, saw it as a non-linear system of written text. In this system all the textual information is accessible from any position through interconnected nodes. Knowledge bases created with authoring packages such as Toolbook 3.0 come close to replicating the hypertext that Nelson envisioned.

Nodes in computerized hypertext environments are represented by highlighted areas called buttons (Sweeters, 1994). Clicking on a button reveals additional information. Hypermedia is hypertext with added graphics, video and sound, (Megarry, 1988). Buttons facilitate nonlinear passage through information as they function rather like a very efficient book index. Individualized instruction can occur in these situations as learners have the option of accessing or circumventing information as they explore
the environment. In other words, users can acquire or ignore information according to their individual needs.

Additional information cannot be requested of linear presentation media, and requests cannot be made for repetition of poorly understood information. Television and radio are perhaps the only truly linear media; the only way information can be reviewed is if programmes are repeated. Video can be rewound, explanatory questions can be asked of lecturers, information can be skipped in a text book and passages can be reread. However, these techniques for using linear media in a non-linear fashion, lack the convenience of computerized hypertext. Many students feel uncomfortable asking questions, and most of us have felt the frustration of skipping through books while trying to find information that will not spring to hand.

Hypermedia and computerized hypertext depend on interconnections and searching capabilities to make information available quickly. Hypertext is not without its problems though, Jonassen (1988) lists experiences that detract from its usefulness. The list has been synthesized below.

1. Few hypertext design principles are available, so where does one begin?
2. How can the subject matter or expert knowledge be made manifest and then mapped into the computer program? Learners
differ in their willingness and ability to assimilate new information, especially when external guidance is lacking. Hypertext designers have to develop structures that maximize information assimilation.

3. When the user navigates through hypertext, what dictates the individual path they take, what navigational aids should be provided and how overt do they need to be for easy use?

4. The multitude of learning options in the hypertext environment can often overload the users cognitive capacity making it hard for them to decide what to learn next.

Obviously these problems have to be resolved if hypertext is to reach it's alleged potential. Fortunately, Jonassen also provides potential solutions to hypertext problems.

How to Structure Hypertext for Maximum Learning

1. Empirical designs.

Monitor the movement of novices through unstructured hypertext. Match different patterns of movement to different learning styles.

2. Experiment with different hypertext designs and observe their effect on recall.
Assessing Knowledge Structures

1. Use semantic networking software or cognitive mapping to determine the cognitive structure of learners. Concept mapping can also be used as a measure of learning by monitoring knowledge reorganization.

Structuring Hypertext

1. Match hypertext to the learning style of the learner
2. Start with an expert's knowledge structure. Concept map the expert's knowledge and match hypertext to the concept map.
3. Software is available to determine differences between expert and novice knowledge structures. The same software can be used to help the learner access relevant portions of expert knowledge.

Individualized Instruction

Teachers have always used a variety of techniques to meet the individual needs of students. Ericksen (1980) advocates individual instruction as a learning mode and sees CBI as a tool that can facilitate it. Ericksen (1980) points to research in the 1950's and 60's in which lectures were significantly reduced or even eliminated from college courses, "without affecting end-of-course student achievement" (p. 14)
Thinking of CBI as the facilitator of a method of instruction implies that it is of secondary importance. Ehrmann (1995) also thinks that method of instruction is ultimately more important than the medium used to present the information. To him, computer hardware is of little benefit, unless teaching methods are changed to accommodate it.

Three features of successful, self-directed education were described by Ericksen (1980): frequent quizzes, immediate feedback, and remediation of mistakes. It is suggested that these features give teachers control over outcomes, and are most effective when objectives are stated clearly and student motivation is maintained. The techniques submitted for maintaining motivation were: the quizzes themselves, group discussions, Socratic questioning, problem solving, paper writing, and the satisfaction gained from self-directed learning of worthwhile material. The above prerequisites for successful self-directed education can be incorporated into the data base structure for the Biology courses at McMaster University.

One more prerequisite for successful self-directed education is student participation (Ericksen, 1980). To Ericksen a system of self directed education demands a high degree of student participation when it is set up correctly. Increased participation implied to Ericksen that students will work harder and learn more. In a computer environment, student participation
would equate to interactivity. Fletcher (1990) as has been noted, found interactivity to be associated with successful IVD tutorials. If a way is developed for incorporating tutorials into the Biology Department's data base they will have to be made as interactive as possible to encourage student participation. Even in the proposed computerized courses where students create presentations, far more participation is required than passive listening to lectures.

The self-education system proposed for Biology courses at McMaster University allows students to uncover information as they generate computerized presentations. Learning in this way resembles discovery learning to some extent. To Nichol et al. (1987), discovery learning increases retention as the content has greater emotional relevance to the learner. At the same time, Nichol et al. (1987) recognize that learning a concept in this way is not always the most effective way of learning a concept. Three guidelines for increasing the effectiveness of discovery learning can be derived from the work of Nichol et al. (1987). Even though the initial courses proposed for the Biology Department do not constitute true discovery learning, the guidelines could and should be incorporated into the proposed system so that a more comprehensive form of self-directed learning will be possible in the future.
1. Match the objectives to the knowledge base of the learner; prior knowledge is necessary for effective discovery learning. The audience for the biology department's self-education system should not experience knowledge base restrictions as they are senior biology students who (hopefully) acquired a base of knowledge in earlier courses.

Stand alone, computer generated presentations can also be used as the learning tool for first and second year courses, provided objectives and guidance are adjusted to match student experience. In the first years of university study this system may not allow for discovery learning, because students require too much guidance. Failure to develop a discovery learning system is not a problem however, because it is not the objective here. The pedagogical objective is a system that permits a motivating and cost effective education.

2. Provide a guide for navigating through the program. Navigation should be as intuitive as possible. The dual task of learning while trying to decipher an interface could prove frustrating and unproductive. Ideally all courses associated with the proposed system would have the same navigational features. Maps could be provided on the data base to help users navigate through the information.

3. Take full advantage of the multimedia elements that are said to be motivational by it's proponents. Motivated students
who are interested in their assignments are likely to put more effort into learning. The difference between CBI and IVD tutorials is the greater number of media involved with the latter. Perhaps the IVD tutorials investigated by Fletcher (1990) were superior to CBI because they used different media in ways that students found entertaining.

With the necessary hardware and software available, computer literate students could add movies and sound to their presentations. With time, computer operations may become intuitive enough that all students can generate MM presentations to present in class. Involving students in every step of a presentation's creation will physically engage them, and should help maintain their motivation. An additional potential motivator is inherent in the proposed system; the chance to have work preserved on next years CD-ROM.

Several readings indicate that Toolbook 3.0 would be a better choice than PowerPoint 4.0 for the proposed system. A good starting point for choosing between the two software packages is to determine which is most suited to CD-ROM. CD-ROM will be used in the proposed system. Megarry (1988), saw CD-ROM as the perfect companion to hypertext, as it can hold large amounts of data in several media formats. Hypertext environments can be created in Toolbook 3.0, but not PowerPoint 4.0.
Nichol et al. (1987) propose combining the archival power of optical storage media with the intelligence and flexibility of computer software, to create an optimal self education system. In this system, the user browses through indexed data that is integrated with simulation and instruction. The user has unlimited control in this system and can annotate and update data as necessary. A goal of this project is to provide a route for fitting the proposed system to the ideal of Nichol et al. (1987); such a route is considered below. Hypertext software is needed for this exercise.

Sweeters (1994) would see the instruction and simulation in the optimum system of Nichol et al. (1987), as nodes of instruction and tutorials. Sweeters describes a tutorial model that contains six elements: introduction, refresher, segments, summary, practice and test. Introductions grab user attention and orient them to the learning objectives. The refresher reviews facts that are covered in more detail in the segments. Recapping occurs in the summary and practice. Practice is designed to tie the segments together and enhance retention. The test is of the same level as the practice and users are expected to pass.

To Sweeters nodes of instruction resemble mini tutorials, but they are less comprehensive and lack: introductions, overviews, summaries and lesson practice. Tutorials and learning nodes also correlate with recommendations in Ericksen (1980), where
they would be equivalent to quizzes that provide students with immediate feedback and the opportunity to correct mistakes.

The data base currently exists on a single CD-ROM as an electronic data base. Sweeters (1994) notes that Robert Gagne's nine events of instruction provide a means for evaluating the functions of any educational system; including an electronic multimedia data base. Gagne's Events of Instruction are presented below.

1. Gain learner attention
2. State the objectives
3. Recall the objectives
4. Present information
5. Provide learning guidance
6. Elicit expected performance
7. Provide feedback
8. Assess performance
9. Enhance retention

The more events of instruction that a system meets; the better it will be. According to Sweeters (1994), educational databases only meet two of Gagne's events of instruction (events four and five). Tutorials with in-built quizzes on the other hand, meet all nine of the instructional events. To optimize the proposed system, the developers would have to link related
student presentations in a hypertext environment and place tutorials strategically within them. The tutorials would cover introductory knowledge the user should acquire before accessing the presentations. The remainder of this chapter considers a route for progressing from an electronic data base on a single CD-ROM to the ideal system of Nichol et al. (1987).

To use a database optimally in a self-education system, Sweeters (1994) holds that learners need to be provided with focused assignments that use the data base as a resource. Random browsing through a data base on a search and find out mission is not likely to meet major educational goals. When using the data base, considerable thought will have to be put into the nature of assignments. Creating a focused task that matches the knowledge base of the students is only part of assignment creation; the assignment must also be pertinent to the material on the data base.

For most courses, professors will probably have to insert computerized presentations that students create into the data base. Professors would also be the most likely candidates for creating navigational routes between presentations. Students are unlikely to have the expert knowledge to develop appropriate data base structure.

Initially lecturers might assign a number of the images to each student. The information on the Fox Pro data base could be
provided as well. Over time the information would be enriched by the addition of more recent knowledge and through links to related information. Using students to create interactive tutorials would not be possible given the current complexity of authoring software and the computing skills of biology students. With considerable thought, it may be possible to assign tasks where students complete parts of tutorials. This would not require extensive programming skills but the professor would still have to link assignments together and create interactive situations.

It is unlikely that professors will have the time to learn how to create tutorials. However this is not sufficient reason to abandon the idea of computerized self education. Challenging, higher order learning assignments can be created using the data base. Furthermore if the technology does become intuitive enough for students to create tutorials that can be added to the data base, the optimal self-education system of Nichol et al. (1987) becomes a possibility. Of course, professors would still have to edit tutorials and position them in the hypertext environment, but such a situation would make reasonable time demands of faculty.

A tree analogy can be used to describe the foreseen structure of data on the CD-ROM; tutorials would be large boughs, learning nodes would be branches and presentations would be the
equivalent of leaves. Menus in the tutorials would contain buttons that lead to related learning nodes, presentations and other tutorials. Buttons in presentations and learning nodes would lead to presentations that explain further minutiae of a subject, or lead back to other tutorials.
Chapter seven

The Design of Student Created Presentations

Rae (1993) cites Tennyson and Breuer (1984) who consider the suitability of material to non-traditional teaching methods such as the Personal System of Instruction used in the Keller Plan; the two main criteria are content and the student. Content refers to the subject matter and has three components; verbal versus non-verbal, concrete versus abstract, and easy versus difficult. Easy, concrete material that can be expressed verbally was considered most suited to non-traditional teaching. More difficult material could be taught with MM as coordinated audio-visual presentations facilitate the teaching of difficult and even abstract concepts (Rae, 1993).

At the moment we cannot say with certainty which material is best suited to MM. The problem is not simply one of not knowing what material to use; we are also unsure how to present information once it has been digitized so that learning and retention are enhanced. We are still seeking efficiency standards for interface montage. Future research to identify suitable subject matter and how to display it could be a fruitful area. Neumann (1993) addressed the impact of data base design on the ability of high-school students to access the material. Although
this work did not result in specific design rules, it did provide a base of knowledge that could be applied to the proposed course. A summary of the problems and potential solutions that Neumann identified follows.

Learning to use data bases and extract information efficiently were common problems because screens were often too crowded and confusing. Standardized menus, containing only pertinent information would reduce the confusion. The use of visual elements was also submitted as a means of guiding user attention. Another suggestion was to group and position headings to guide user attention and denote importance. No ideas for guiding user attention with text were presented but highlighting, colour coding and varying font sizes are obvious suggestions.

Neumann thought a standardized interface would facilitate navigation. Icons and other visual elements could be used as additional navigation aids and they should contain text which details the material they represent. Other potentially useful additions to CD-ROM data bases include: memory aids such as a notetaker, fields containing colour code keys, and hints for accessing increasingly targeted information. The source, publication date, and curriculum area of material could also be included.

The issue of text position and grouping was taken up by Burns (1985). In this study, students viewed three different
multi-image presentations and recorded their recollections. The findings are presented below as they are useful design suggestions for the student created presentations.

1. Impact was greatest in the first five minutes; students recalled thirty five percent of the information presented.

2. Impact declined but was relatively constant for the next two five minute portions. Recall was lowest for the fifteen to twenty minute interval.

3. Enumerated items with accompanying photographs and text were recalled most easily.

4. The sooner an enumerated item appeared, the greater it's impact.

5. When parallel ideas were presented, the idea presented first had greater impact.

6. Presenting a fixed number of ideas in a shortened time span did not affect recall, unless compression was too great for comprehension.

7. Presentations with more than forty ideas or pieces of information were not as efficient. Recall fell as the information load increased.

Burn's findings imply that presentations should be relatively short in terms of time and content. The most
important information should appear in the first five minutes and should be enumerated with an accompanying image and text. Burns found that recall can be increased in the eighteen to twenty minute interval by preceding information with an unusual occurrence such as a black screen. A dramatic special effect could be especially useful for increasing recall when the main ideas are recapped at the end of presentations. Repeated use of a special effect should be avoided though because the effectiveness quickly declines (Burns, 1985).

In a paper which describes the impact of video and animation on memory Park (1994) defines these "dynamic visual displays" as any type of pictorial or graphical movement during instruction. Park captures the current state of educational video use in the final remarks with a citation (Freeman, 1924): "The effectiveness of motion ...has undoubtedly been overestimated in comparison with slides, stereographs, still pictures, and demonstration. They were not as effective as some people claim them to be...(However,) motion pictures have a distinctive part to play."

Taylor (1992) sheds some light on the part video can play, noting that it is more suited to broad abstract material rather than detailed information. Advance organizers and lesson summaries were thought to be examples of appropriate video use.
Park (1994) contends that video's inconsistent performance as an instructional tool is due to a failure to apply its unique features strategically. Using recent research findings and theoretical discussions, Park suggested a number of instructional roles and conditions for using dynamic visual displays. The roles and conditions have been combined and summarized below.

1. **An attention guide.** Salient features and relationships can be emphasized by motion. In complex machinery, the movement of gauges may be difficult to illustrate using the actual equipment. Animation and video can be used to focus on whatever the instructor wishes to demonstrate.

2. **An illustration aid.** Videos can illustrate the structural, functional and procedural relationships of components which cannot always be demonstrated adequately with pictures. Video can also provide instruction when actual equipment or live demonstrations are not available.

3. **Knowledge representation.** If a concept involves motion, video may be the best way of representing it. Animation can simplify cause and effect relationships in complex systems. Here, dynamic visual displays can serve as a training aid when use of the actual equipment would be risky or expensive.

4. **A facilitator of mental model formation.** Phenomena and systems that are not directly observable, (such as blood flow) or
are difficult to explain, can be represented by animation. Mental models facilitate conception and subsequent manipulation of systems.

5. A reasoning anchor for abstract and symbolic concepts. Abstract concepts such as acceleration can be made concrete by animation.

6. Representing tasks that are difficult to describe verbally. Verbal information is processed linearly, which can make explanations of complex systems difficult to understand. Dynamic visual displays are superior instructional tools in this situation as they are processed in a fashion that parallels the operation of the system.

At a minimum, Park feels that video should highlight the content and processes that are required for learning. Verbal explanations are important accompaniments to video as they guide learner attention. Without adequate explanation, relationships essential to comprehension may not be understood. Park also suggests video's speed of play should take account of the complexity of the task and the sophistication of the audience. Unfortunately, Park provides no suggestions for the strategic application of verbal explanations, or on ascertaining appropriate speed of play.

Grimes (1989) investigated the effect of differing agreement between audio and visual channels upon retention of TV news. He,
like Fletcher (1990) considers that findings obtained for one audio-visual medium are applicable to others. The following description of attention, audio-visual correspondence and retention should therefore be applicable to MM.

Attention is a limited commodity that is subjected to additional stress when the message delivered on audio and visual channels differs slightly (Taylor, 1992). When channel correspondence decreases sufficiently, the capacity of attention is exceeded. Grimes (1989) found that when the information passing through the two channels correlates well, subjects split their attention between them equally.

When the differences between audio and visual channels are small, auditory recall exceeds visual memory (Grimes, 1989). When differences between the channels are significant though, the opposite is true and visual recall exceeds auditory recollection (Grimes, 1989). Grimes thought that the audio channel is favoured under medium dis-correspondence conditions, as it contains the what, where, why, when and how of a story. When the strain on attention is significant though, visual images are recalled most efficiently as they require less processing (Dhawan and Pellegrino, 1977; Pellegrino, Rosinski, Chiesi, and Siegel, 1977; Smith and Magee, 1980; as cited by Grimes, 1989). Grimes does not address the issue of actually correlating audio and visual channels, but the
implication for MM presentations is to carefully coordinate audio-visual correspondence.

Video clips can be imported into both Toolbook 3.0 and PowerPoint 4.0 provided a video capture board and capture software is available. Considerable planning would be needed during the video capture stage to ensure that the information contained in the audio and visual channels is related.
Chapter eight

Matching the Proposed System to Behaviourist and Cognitive Psychology Theories of Learning

Rae (1993) describes a university mathematics course that uses MM and is based on a behaviourist model, the Keller Plan. It is stated that the Keller plan or Personalized System for Instruction (PSI) is a proven learning tool which depends on "printed self instructional units with one-to-one tutorials and a diagnostic test to ensure that each unit is thoroughly mastered before the next is attempted" (Rae, 1993). The popularity of PSI has suffered due to the salary expenses associated with human tutors for one-to-one tutorials. Ironically the one-to-one tutorials account for a large part of PSI's effectiveness. Rae found that incorporating computerized tutorials into optical storage media retained high student performance outcomes and eliminated the salary costs. In fact, if the cost of hardware was discounted, the MM, PSI course was considered to be cheaper than the traditional, lecture based mathematics course it replaced.

Rae (1993) provides a copy of the The Keller Plan which is taken from the Keller Plan handbook (Keller and Sherman, 1974).
The Keller Plan

1. The material to be taught is broken up into units, each representing at most one week's work. Printed material suitable for self study is handed out on each unit.

2. Tutorial help is given on a one-to-one basis, preferably by senior students (who are themselves rewarded by course credits for doing this teaching).

3. When a student feels s/he has mastered a unit, s/he takes a diagnostic test. This test is marked by a tutor and if the student passes (the pass mark being high, say 90%) s/he goes on to the next unit; if not, the test is retaken at a later date.

4. There is a final examination which counts for about 30% of the marks, the remaining marks are acquired by passing the units.

5. Occasional lectures are given as a reward to those students who have passed enough units.

If computerized tutorials could be developed, many if not all of the components of the Keller Plan could be incorporated into the proposed system. The reduced lesson preparation associated with a self-education course may free faculty up sufficiently to do the necessary work to break each course up into twelve, one week units. Each unit would be an assignment associated with the data base of student generated presentations and it's tutorials.
Scheduled class discussions to cover student problems would replace the reward lectures. These meetings may also prove important in offsetting any feelings of isolation that a self-directed education system engender. A further solution to potential isolation problems is to have students work in pairs. Rae (1993) found that students working in pairs were almost as productive as student-tutor couplings. Tests incorporated into tutorials would replace the unit tests and the need for a final examination would depend on the nature of the course.

A final comment Rae offered was that the MM Keller Plan course, allowed more students to pass. The reason tendered for the increased pass rate was reduced student burn out. Neumann et al. (1990) attributed student burnout to a lack of flexible learning resources and student involvement. The proposed system would certainly engage students, especially if flexible MM technologies become intuitive enough for students to incorporate different media into the presentations they create.

In the 1980s, instructional design theory began to be influenced by cognitive science more than behaviourist principles. Cognitive theories of learning are largely theoretical (Taylor, 1994), whereas the behaviourist model of learning is well established (Tennyson, 1992). Not surprisingly then, the switch generated some confusion.
The solutions Jonassen (1988) submits for overcoming problems with hypertext are more in keeping with cognitive psychology than behaviourist principles. Kumar (1994), explores a cognitive psychology definition of the computer's role in assessing the learning process. It is hypothesized that learning and human knowledge can be investigated by combining hypermedia with theories of learning. Like Jonassen (1998), Kumar (1994) suggests using concept maps to replicate the structure of an individual's knowledge and illustrate the difference between experts and novices. Similarly both Kumar and Jonassen indicate the differences between the concept map of an expert and a novice can be used to suggest routes for expert knowledge acquisition.

Using previous research (Bower and Hilgard, 1981; Halasz, 1988; Jonassen, 1988; Sowa, 1984; Yates and Chandler, 1991) as evidence, Kumar (1994) proposed that the links and nodes used in hypermedia can emulate the structure of a human's knowledge. By tracking users movements through hypermedia, Kumar (1994) proposes a route to increased understanding of learning might be reached.

Tracking devices and time on task devices could be incorporated into the proposed system of student presentations and tutorials. Their use would be limited at the moment as the requisite skills for interpreting the results obtained from the tracking and time on task devices are not available. The data may prove useful at a later date if interpretation becomes
feasible. Indeed, if interpretive skills become available, the data may be essential for improving the system. In the mean time the problem can be circumvented to some extent by adapting the structure and linking of the student presentations and tutorials to cognitive psychology theories.

The Tennyson Theory of Learning

In an attempt to match learning to cognitive function, Tennyson (1992) tendered a model to explain learning. In the model, external and internal stimuli enter the brain through sensory receptors. In an executive control component of the brain, attention and perception determine which subsets of the stimuli undergo further processing in working memory. Information in working memory is compared and matched with long term memory; it may even be reordered. After manipulation in working memory, information enters long term memory. Finally, the model acknowledges an affective component to cognition which influences the efficiency of all the other components. The model was designed as a base for the design of instructional tools. In other words, instructional tools designed according to Tennyson's model would complement this conception of memory function. The functions of the components of the Tennyson theory of learning are summarized below.
Cognitive Domain

1. Sensory receptors are the ways in which information (external or internal) enters the cognitive system.

2. Executive control is provided by a processor with active or automatic control over the system's components.

3. Working memory, processes information before it enters long term memory. Working memory has a limited capacity.

4. Long term memory has unlimited capacity and it represents knowledge as skills, content and strategies. Knowledge in this component of the brain is considered to be permanent.

Affective Domain

This works with all the other components in processing and retrieval. This is an important component of instruction design as emotions may actually dominate the cognitive domain.

Taylor (1994) built upon Tennyson's educational theory of learning to generate a tentative model of human information processing. The model is an attempt to understand the cognitive skills and knowledge structures of experts and novices and is used to generate a step wise approach to instructional design. The instructional design steps have been paraphrased and condensed below.

1. Specify the desired outcome.
2. Analyze and represent an expert knowledge base and pay due attention to affective knowledge.

3. Use the expert knowledge base to determine the current status of student knowledge.

4. Design a path through the expert's knowledge according to the differences between expert and student knowledge.

5. Design examples and exercises that require a variety of cognitive functions.

6. Present the pertinent expert knowledge to the student.

7. Provide performance feedback.

8. Assess the performance of the instructional system.

To adapt Taylor's steps to the proposed system, the professor would have to specify the desired outcome when setting the assignment. Over time as the number of presentations increases, professors could link information as they saw fit. Linking presentations would result in the database resembling the knowledge structure of the expert. The fidelity of the comparison to expert knowledge would depend on the nature of the links between presentations. Steps three, four, five and six of this approach to instructional design are the most difficult to recreate with the proposed system.

An alternative to concept maps would be to determine student performance on introductory tutorials. The tutorial could
automatically track the material that could not be recalled, and provide each student with database addresses containing appropriate material for review. This solution does not accommodate the unique knowledge of individual students, but it does ensure a base of knowledge throughout the class and gives the professor a starting point for generating assignments.

MM tutorials and presentations would be designed to provide stimulating examples, pertinent knowledge and immediate feedback. The technique used in the introductory tutorials to find poorly understood material could be used to present a path to pertinent knowledge. That is, addresses of pertinent expert knowledge would be provided to students according to their performance on the tutorials. The results of tutorial tests would be the immediate feedback Taylor calls for. Ericksen (1980) suggested successful discovery learning requires a chance for remediation of mistakes; such remediation could be provided for in the tutorials by providing addresses for extra problems as they are needed.

Conceivably, professors could coordinate courses so that assignments completed by first and second year students can serve as review material for senior courses. Two functions would be served in this situation; first, junior students become familiar with computerized courses and second, faculty are relieved of the burden of providing background material. Faculty would still have to link the material together and make
computerized interactive tutorials. If the potential for reduced lesson preparation offered by the self-education system is exploited, it may make it possible for faculty to acquire the programming skills needed for making computerized interactive tutorials. There are several companies available who specialize in teaching development software skills in a short period of time.

Only one of Taylor's instructional design steps has yet to be considered; ascertaining the performance of the system. Different courses need different assessment procedures, but the quality of student outcomes will always be an assessment factor, regardless of the course.

The potential for bringing about the desired student learning using the proposed system could be assessed through student performance on tests and examinations. On courses where students create presentations, assessing the learning that has occurred is a harder task. Examinations are not feasible when different students have covered different material. The lecturer would have to incorporate less tangible factors into the marking scheme, such as the complexity of the material, the amount of editing needed before the presentation could be placed into the data base, etcetera. A study of how much time was needed for students to complete assignments is another suggestion for a system assessment method. Changes in student performance over time would reflect the quality of the evolving system and
monitor the quality of assignments. Similarly, qualitative assessments of time on task and student motivation could be used to monitor the system without incurring the expense of monitoring staff.
Chapter nine
Summary and Future Steps

Problems with Toolbook 3.0 and PowerPoint 4.0

Initially it was hoped that students would be able to create presentations at home, downloading images from the CD-ROM into a suitable software package. This is not feasible with the file formats and software investigated in this project. At the moment the Biology Department has twenty-five hundred images on CD-ROM or computer tape. Creating presentations with this set up requires a software package that can import JPEG files. Neither PowerPoint 4.0 nor Toolbook 3.0 can import JPEG files; intermediary software is needed. The expense of intermediary software and the inconvenience of familiarizing students with it reduces the usefulness of Toolbook 3.0 and PowerPoint 4.0. Another file format could be used on the CD-ROM, but the files would still have to be compressed to squeeze the images onto a single CD-ROM. JPEG is likely to become the standard compression/decompression algorithm, so it will probably be better to stick with JPEG and find software that can utilize it.

The ideal educational system envisioned by Nichol et al. (1987) requires a hypertext environment. The proposals in this work are designed to guide the Biology Department so that the
current computerized data base can be built into a system resembling the deal of Nichol et al. (1987). The ideal system stipulates that users should be able to learn as they browse through information; they should also be able to make notes and editorial changes as they see fit. To match this system, a hypertext environment is needed. At the moment though, the Biology Department is simply deciding which software students should use to create presentations. It has been noted that a critical step in the development of the Biology Department's system will be incorporating a facility whereby students develop tutorials to add to the data base. It is hoped that software will soon be available that will allow students to create their own tutorials. The tutorials that students generate would be used to introduce topics and provide background information. In some courses, students may be required to simply learn the material on a number of tutorials. Other courses may require that students create presentations to explain the tutorial material in greater detail. The choice of software for the initial courses is difficult and important. Given the speed of technological change in the computer industry, the Biology Department can only guess at the future usefulness of a software choice.

PowerPoint 4.0 is not suited to the proposed system as it does not permit hypertext environments. If it had been possible to import the presentations into Toolbook 3.0, the problem would
have been resolved; unfortunately their file format is not suited to this transaction. Although not suited to hypertext, PowerPoint 4.0 has three powerful attributes that the ideal software package should possess. First, creating aesthetically pleasing displays is very easy with PowerPoint 4.0, no scripting techniques have to be learned. Second, PowerPoint 4.0 provides prompts that guide the structuring of presentations. A standardized presentation format is suited to the proposed system as it facilitates exploration of the presentations as well as their development. Finally, PowerPoint viewer makes the presentations very mobile; presentations developed at home can be assessed by faculty and viewed by other students on any compatible computer.

Toolbook 3.0 permits a hypertext environment but the discounted, education price for Toolbook 3.0 is $749. At this price, Toolbook 3.0 cannot be provided to every student. A site license would decrease the cost considerably, but students would still not be able to complete assignments at home. Even if Toolbook 3.0 could be provided for every student to use at home, a number of other problems prevent this software from meeting the requirements of the proposed system.

1. Toolbook 3.0 does not work on Mackintosh computers. Many students already possess such a computer and it would probably not be unreasonable to insist that new students acquire one. Insisting that students who have invested in a Mackintosh now
reinvest in a P.C. might be considered an unreasonable request though.

Macromedia Macromind Director 4.0 might have been a better software choice as it comes in P.C. and Mackintosh compatible versions. Unfortunately porting tutorials and presentations between the two platforms would be a considerable administrative task. Any time savings faculty may enjoy with the proposed system could be lost.

2. The JPEG files are only about 200 kilobyte each, but they increase to five time this size when converted to bitmap files. To manipulate these files in a reasonable amount of time, students need a fast computer. The cost of a system capable of handling such large files may be prohibitive to many students. The goal of the proposed system is more meaningful education, but not at the expense of equity.

3. Toolbook 3.0 lacks prompts for creating a presentation that are available with PowerPoint 4.0. For the initial courses this problem could be overcome by providing students with a text file containing appropriate presentation creating information. Conversely the prompts could be placed on a CD-ROM along with the images and made available to students. Students could then paste the file into the first page of a Toolbook 3.0 book. Though a solution, this alternative is not as efficient as the prompts built into PowerPoint 4.0
4. If presentation creation was restricted to P.C.'s on campus, students would be spared the expense of a computer. Even if this were the case the extensive programming skills needed to make interactive tutorials would still make Toolbook 3.0 an unsuitable choice for emulating the ideal system of Nichol et al. (1987).

The Data Base Structure

For the proposed system of student generated presentations, the ideal software would be cheap enough to distribute to all students, would require no programming skills, be able to handle JPEG files, and work on both IBM and Macintosh machines. One final attribute of the ideal software would be the provision of prompts to guide presentation development. It is possible that software possessing the above attributes is available at the moment; more software should be investigated to determine if this is the case. The decompression of the JPEG files is another potential barrier to home use of the proposed system. Students wishing to use CD-ROM's at home will need a computer powerful enough to handle the JPEG files in a reasonable amount of time. The cost of computers capable of the required file manipulations may have to decline considerably before all students can afford them.

The meta-analyses revealed that CBI and MM can positively affect several education outcomes: increased student performance on examinations, reduced instruction time and increased student
motivation and enjoyment of a course. Some of the CBI and MM courses examined in the meta-analyses performed better than others; unfortunately we do not know the cause of the variation. Although exciting performance outcomes have been observed, this potential cannot be harnessed with the regularity we would like. Gates' (1993) has claimed that MM can be used to teach the most difficult courses because it can use the media type most appropriate for teaching a concept. A more accurate claim would be that although the most suitable type of media may be available in a presentation, without appropriate assessments of student learning, we do not know if the right medium is being used at the right time.

Despite our knowledge gaps, the papers reviewed for this project reveal some basic guidelines for creating MM courses, tutorials and presentations. For example, MM courses should be of short duration and tutorials should be as interactive as possible. Also research indicates that a hypertext environment will be the most appropriate for the CD-ROMs that would be under consideration in the Biology Department at McMaster University. Although the twelve week semester system cannot be avoided, courses could be designed to mimic several short courses, so that student interest is maintained. For example, in the early stages of data base development when courses would simply involve students creating presentations that relay information pertaining
to the images in the data base, students could be assigned one image per week. Changing the subject matter may delay or avoid the onset of declining student motivation that accompanies longer CBI courses. Any novelty effect associated with changing the subject matter could be enhanced by switching the source material among the library, the internet, encyclopedias on CD-ROM, etcetera. Once the data base is complete enough to be used as a text book for courses, the variety of learning exercises that could be used would be limited only by the nature of the material, the imagination of the professor, and the technical limitations of the system.

If the proposed system develops to the stage where several Biology courses and tutorials can be offered to students, concept mapping and facilities for matching learning styles to the data base are unlikely to be used, given the current state of the technology. The simplest, and most feasible approach the department can take is to let professors construct hypertext links within the data base as they see fit. Over time the professors knowledge links would be replicated in the proposed data base system.

Computerized tutorials would provide the frequent quizzes, immediate feedback, opportunities to remediate mistakes, and student participation that Ericksen (1980) considered necessary for successful individual instruction. The greater the
interactivity of the tutorials, the greater the student participation.

The ideal software package would permit tutorial creation with a level of computer literacy similar to that required for using a word-processor. Software products, such as PowerPoint 4.0 make page turning and other common features of MM presentations easy to perform. It is conceivable that in the near future, enough frequently used MM presentation features will be available at the push of an icon that interactive tutorials can be created as easily as writing a document. This development would facilitate tutorial development by students and overcome the current obstacle of limited faculty time.

An in-house product could be developed to make tutorial development easier, but it would be preferable if a commercial product were available. It is well known that the computer industry is working towards standardizing its MM products. With standardization, presentations developed by biology students at McMaster University could be made available to other educational institutions by way of the internet. Students would also be likely to learn a commercial product faster than an in-house product as the interface and icons would be familiar to them. It is likely that the interface of such a commercial product would be very complex. To reduce this complexity, the software should be set up so that icons with functions pertinent to the course
could be placed on one toolbar; the other icons could then be
hidden. Icons and toolbars can be moved and hidden in PowerPoint
4.0.

Familiarizing students with a CD-ROM's layout and any
requisite navigation procedures facilitates the learning of the
contents of the CD-ROM. The simplest situation is to ensure that:
navigation facilities, colour coding, graphics, and the positioning
and size of text are the same throughout the data base. Similarly
the presentations and tutorials should be of the same format.
Faculty interested in computerized courses will have to
collaborate before the first courses begin so that a series of
standards can be devised. Contributions to the data base would
have to conform to the standard as far as possible. Deviations
from the standard would probably be few because most biology
courses use text books that can be mimicked by hypertext
software packages that are based on the book metaphor.
Guidelines for creating presentations should also be included on
the CD-ROMs. The greater the importance of the material the
sooner it should appear in a presentation. Graphic elements
should be enumerated and relevant text should appear on the same
page. Any video that is included should cover broad abstract
material or be used to guide user attention and help with mental
modeling. Sound to accompany the video should be carefully
coordinated so that the content of both channels is synchronized.
Guidelines for using audio-visual material could also be placed on the CD-ROM to help those students who already possess the skills to create MM presentations.

Although CD-ROM's have a large storage capacity at six hundred and forty megabytes, the presentations students create for just one or two courses will probably increase the size of the data base beyond this limit. Professors would then have to decide how to store the material. Perhaps the best solution would be to amalgamate all the material and place it on a server. The material could be linked on a per subject basis but students should be able to browse through all the material if they wished. The data base addresses of relevant material would have to be given to students along with the assignments. An alternative would be to press CD-ROMs for individual courses. Each student could be asked to purchase a CD-ROM to use throughout the semester.

No matter how the material is stored, the data base can only be made comparable to the Keller Plan and the Taylor model of human information processing when some means of tutorial creation is available. Rae (1993) noted that students want answers to their questions immediately, and that having to wait for the next scheduled tutorial was frustrating for some of them. It has already been noted that when human tutors were used in the Keller Plan their salaries made this successful technique
prohibitively expensive. Computerized tutorials do not have to be paid a salary.

The cost of the proposed, ideal system is unknown, largely because the software and hardware needed to run it are also unknown or unavailable at present. This project indicates that now would be a good time for the Biology Department to start collecting information about the cost of traditional Socratic courses. With this information it will be easier to assess the economics of the proposed computerized education system.

If the ideal system described in this project is developed by the Biology Department, it would correspond to both the Keller Plan and Taylor's model of information processing. This correspondence implies that the ideal system proposed for the Biology Department would likely meet with success with respect to the issues of student motivation, enjoyment, engagement and reduced learning times.
Bibliography


